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DiamondSoft Font Reserve Software License Agreement
IMPORTANT: YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND
CONDITIONS OF THE LICENSE AGREEMENT TO DETERMINE WHETHER YOU
AGREE TO BE BOUND BY ITS PROVISIONS.

This software program ("Software") is a proprietary product of DiamondSoft, Inc.
("DiamondSoft") and its suppliers and is protected by copyright laws, trade secret laws
and international treaty. Use of this Software is governed by this license agreement and
applicable law including copyright law.

This agreement is a legal contract between the user of this Software and
DiamondSoft. Installing this Software indicates that you agree to be bound by the
terms of this license agreement.

If you do not agree to be bound by the terms of this license agreement, promptly
return the complete software package to DiamondSoft, or the place where you
obtained it, for a full refund.

1. Grant of License. DiamondSoft grants you a non-exclusive license for the use of the
Software as follows. You may:

(i) use one copy of the Software on a single computer;
(ii) make one copy of the Software for archival purposes, or copy the Software onto

the hard disk of your computer and retain the original for archival purposes;
(iii) use the Software on a network, provided that you have a licensed copy of the

Software for each computer that can access the Software over that network;
(iv) after written notice to DiamondSoft, transfer the Software on a permanent basis

to another person or entity, provided that you retain no copies of the Software
and the transferee agrees to the terms of this agreement.

2. Restrictions. Ownership of the legal rights contained in the Software and the associ-
ated documentation shall remain solely with DiamondSoft and its suppliers. These
may include trade secret, trademark, copyright, patent, international treat and other
rights as applicable. You may not:

(i) sublicense, rent or lease any portion of the Software;
(ii) reverse engineer, decompile, disassemble, modify, translate, make any attempt to

discover the source code of the Software, or create derivative works form the
Software.
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3. Export Control. The Software may be subject to United States export control. You
agree to fully comply with all applicable United States export regulations.

4. U.S. Government Restricted Rights. If you are purchasing the Software on behalf of
the United States Government or any unit or agency thereof, you acknowledge that the
Software and accompanying materials were developed at private expense and that no
part is in the public domain and that the Software and documentation are provided
with restricted rights. Use, duplication or disclosure by the government is subject to
restrictions as set forth in Subparagraph (c)(1)(ii) of the Rights in Technical Data and
Computer Software clause at DFARS 252.227-7013, or Subparagraphs (c)(1) and (2) of
the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as applica-
ble. Contractor/manufacturer is DiamondSoft, Inc., 250 Camino Alto Suite 200, Mill
Valley, California 94941.

Limited Warranty
5. Limited Warranty. DiamondSoft warrants that the media on which the Software is
recorded will be free of defects in materials and workmanship under normal use for 90
days after the date of original purchase. If a defect occurs during the 90-day period,
you may return the media to DiamondSoft for free replacement. DiamondSoft will
replace the media provided that you have previously registered as a user of the
Software. DiamondSoft does not warranty that the Software will meet your require-
ments, that the operation of the Software will be uninterrupted or error-free.

6. Disclaimer of Warranties: THERE ARE NO OTHER WARRANTIES WITH
RESPECT TO THE SOFTWARE OR ACCOMPANYING MATERIALS. DIAMOND-
SOFT DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUD-
ING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE OR THOSE ARISING FROM
TRADE USAGE OR COURSE OF DEALING. NO ORAL OR WRITTEN INFORMA-
TION OR ADVICE GIVEN BY DIAMONDSOFT, ITS EMPLOYEES, DISTRIBU-
TORS, DEALERS OR AGENTS SHALL INCREASE THE SCOPE OF THE ABOVE
WARRANTIES OR CREATE ANY NEW WARRANTIES.
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Some States/Jurisdictions do not allow the exclusion of implied warranties, so the
above exclusion may not apply in certain states/jurisdictions. In that event, any
implied warranties are limited to the maximum extent permitted by applicable law or
ninety (90) days from the date of delivery. This warranty gives you specific legal rights.
You may have other rights, which vary by state/jurisdiction.

7. IN NO EVENT WILL DIAMONDSOFT BE LIABLE TO YOU FOR DAMAGES,
WHETHER BASED ON CONTRACT, TORT, WARRANTY OR OTHER LEGAL OR
EQUITABLE GROUNDS, INCLUDING ANY LOSS OF PROFITS, LOST SAVINGS, OR
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR
USE OR INABILITY TO USE THE SOFTWARE, EVEN IF DIAMONDSOFT, OR AN
AUTHORIZED REPRESENTATIVE OF DIAMONDSOFT HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE. DiamondSoft's entire liability and your
exclusive remedy shall be at DiamondSoft's option to either return the price paid for
the Software, or repair or replace the Software that does not meet DiamondSoft's
Limited Warranty and which is returned to DiamondSoft provided that you have previ-
ously registered with DiamondSoft as a user of the Software, or provide a copy of your
purchase receipt. This limited warranty does not apply if the failure of the Software has
resulted from accident, abuse or misapplication. In no event shall DiamondSoft's liabili-
ty exceed the purchase price of the Software. Some states/jurisdictions do not allow the
exclusion or limitation of liability for consequential or incidental damages, therefore,
the above limitations may not apply to you.

8. This Agreement is governed by the laws of the State of California. Should you
have any questions regarding this Agreement, or wish to contact DiamondSoft, Inc.
for any reason, please write: DiamondSoft, Inc., 250 Camino Alto, Suite 200, Mill
Valley, CA 94941.
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Chapter 1: Font Reserve Overview

Welcome to Font Reserve — the unique font management software designed to

forever change the way you work with fonts. You’ll no longer struggle with the

various font components and types ranging from suitcases, bitmap fonts, and out-

line fonts to Multiple Master, TrueType, and Type One fonts. Font Reserve man-

ages the physical fonts files for you, preventing you from ever digging through

folders and suitcases again.

Font Reserve consolidates all your font files into one convenient place and provides

an intuitive method for locating, activating, deactivating, grouping, and viewing

them. There’s no need to close most applications to make fonts available, it’s easy to

export fonts for delivery to a service bureau, and you can share fonts with an entire

workgroup. Depending on the application you’re using, Font Reserve can activate

the fonts required by each document you open. With Font Reserve tracking your

font files, you’ll spend less time hassling with fonts and more time working.



Introducing Font Reserve

Font Reserve works by compiling all the fonts you specify into a database called a
“catalog.” The catalog consists of pointers to fonts, whether they’re in Font Reserve’s
font repository called the “vault,” on your hard drive, on a CD-ROM, or on another
volume. You access the Font Reserve catalog through the Font Reserve Browser — a
front-end application that lets you sort, preview, and manage all your fonts.

Compiling Fonts
When you install Font Reserve, the database is empty. You need to locate all the fonts
you want to manage with Font Reserve and add them to the database. When you add
fonts to the database, Font Reserve does the following:

• Examines your font files for corruption

• Prevents addition of duplicate fonts

• Matches the bitmap and outline components of PostScript fonts

• Isolates orphaned fonts, whether they’re missing the bitmap or outline portion

• Organizes font files that you place in the vault in a logical hierarchy of folders

Once your fonts are in the database, you can delete or reinstall any corrupt or orphaned
fonts so all the fonts on your computer are usable. As you acquire new fonts, you can
quickly add them to the database for a single use or for long-term use.

Sorting Fonts
The sorting options in the Font Reserve Browser help you locate the fonts you need.
You can list fonts individually, by family, or by suitcase, and you can sort fonts by
name, design, foundry, etc. You can also specify your own search criteria, called “fil-
ters,” to locate certain fonts. For example, you might create a filter to locate all the
fonts from a specific foundry that are stored on a specific volume.

2 — Using Font Reserve

Chapter 1: Font Reserve Overview



Previewing Fonts
To find fonts by their look rather than name, you can preview them. Font Reserve lets
you customize the text, point size, and leading used when you preview fonts. If you
prefer selecting fonts from a traditional “type book,” you can print one consisting of
any fonts you wish.

Managing Fonts
The Font Reserve Browser allows you to manage your fonts — adding new fonts,
deleting old fonts, activating and deactivating fonts, and grouping fonts into “sets” for
specific jobs and clients. Once fonts are in a set, you can activate and deactivate them
simultaneously, copy the set to a back-up disk, or easily export fonts for transportation
to a service bureau.

Font Reserve Workflow
Font Reserve is designed to streamline your workflow by preventing you from
relaunching applications to update font lists, searching for font files to activate, and
dealing with corrupt fonts. Take a look at how Font Reserve works in the following
publishing scenarios.

Let’s say a service bureau receives a ZIP disk containing a PageMaker document and a
folder of fonts. The service bureau employee does the following:

• Launches the Font Reserve Browser

• Drags and drops the folder of fonts into the Sets area so the fonts are grouped

• Specifies that the fonts be left on the ZIP disk, not moved to the hard drive

• Specifies that the fonts be added temporarily (so they’re removed when the comput-
er is restarted)

• Specifies that the fonts are active and ready for use

• Opens the PageMaker document and prints it, accessing the fonts on the ZIP disk

After the document is printed and the computer is shut down for the day, the fonts are
removed from the database. This workflow guarantees that each job is printed with the
fonts provided, and that unnecessary fonts aren’t loaded on the computer.
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Font Reserve provides options ideal for graphic design situations in addition to pro-
duction environments. Let’s say a designer is working on a brochure for a client. The
client’s corporate identity involves two font families, but the designer is free to incor-
porate other typefaces into the design as well. To use these fonts consistently, the
designer does the following:

• Purchases a CD-ROM containing the corporate fonts

• Locates the fonts on the CD-ROM and drags them into the Fonts area of the Font
Reserve Browser

• Specifies that the fonts are moved into the vault so they’re always available in the
database for this client’s jobs

• Creates a new set for the client and adds the corporate fonts to it

• Previews and prints samples of various other fonts that might be used

• Selects several other fonts for the job and adds them to the set

• Activates the font set temporarily

• Creates an initial design in QuarkXPress and sends it to the client for approval

• Shuts down the computer for the day, deactivating the temporarily active fonts

• Opens the QuarkXPress document several days later to incorporate changes

• Allows Font Reserve to automatically reactivate the fonts used in the document

• Finishes the job and copies the font set to a ZIP drive, creating a copy of the fonts
for the service bureau

• Receives additional jobs from the client and changes the font set to permanently
active (so the fonts are always available)

The ability to create sets and automatically activate fonts offers graphic designers a
quick method for managing fonts for specific jobs.
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Font Reserve Components

Font Reserve is a coordinated suite of tools that consists of a database, applications for
managing fonts, and a system extension for activating fonts. Aliases to the applications
are distributed on your computer as necessary.

Font Reserve Database
Font Reserve is a database program — similar to Filemaker Pro or Quicken — that
maintains and sorts data. The Font Reserve database consists of the Font Reserve
application and the files in the Font Reserve Database folder.

• The Font Reserve application is in the Font Reserve 2.0 Folder at the root level of
your hard drive. This application is responsible for activating, deactivating, copying,
deleting, searching, and sorting your fonts. The application has no interface and
runs in the background whenever it’s turned on. All communications with the Font
Reserve application take place through Apple Events messages sent by other applica-
tions.

The Font Reserve application.

• The Font Reserve Database folder consists of three folders of font data. The Catalog
folder stores data about the fonts you have added to Font Reserve. The Suitcases
folder contains temporary suitcases that Font Reserve uses when activating copies of
fonts (see “Methods for Activating Fonts” on page 66). The vault contains the physi-
cal font files for fonts added via the vault method (see “Methods for Adding Fonts”
on page 42).

The Font Reserve Database folder.

Note: There is no need to open the Font Reserve Database folder or access fonts in
them. Font Reserve provides applications for all font management tasks.
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Font Reserve Settings Control Panel
The Font Reserve Settings control panel is in the Font Reserve 2.0 Folder at the root
level of your hard drive. This control panel serves as the user-interface for the Font
Reserve application, allowing you to enable and disable the database, automatically
activate fonts used in documents, change the memory partition, and manage the Font
Reserve Database folder.

The Font Reserve control panel.

Note: The Font Reserve Settings control panel is actually an application, which means
you can use it even when you start your computer with extensions off. Since the appli-
cation functions similar to a control panel, and has an alias in the Control Panels fold-
er, it is referred to as a control panel.

Font Management Applications
When you install Font Reserve, the font management applications are placed at the
root level of your hard drive in a folder called Font Reserve 2.0 Folder.

The Font Reserve 2.0 Folder.

The Font Reserve applications serve the following purposes:

• The Font Reserve Browser lets you manage fonts, including adding, deleting, acti-
vating, deactivating, grouping, previewing, and sorting. Most operations you per-
form in the Browser send an Apple Events message to the database. Therefore, you
can only launch the Browser when Font Reserve is running.

• The DropFont applet allows you to add fonts quickly without having to launch the
Browser. Drag-and-drop volumes, folders, suitcases, or individual fonts onto its icon
and any fonts found will be examined and added to the database.
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• The DropSet applet works like the DropFont applet, allowing you to drag and drop
volumes, folders, suitcases, or individual fonts onto its icon for addition to the data-
base. Once the fonts are added, DropSet automatically creates a set for each folder
and/or volume. The sets consist of pointers, called font references, to fonts in the
database.

• The FR Relauncher application helps Font Reserve restore itself correctly after a sys-
tem crash or power interruption. Since FR Relauncher is launched automatically as
needed, you will not need to interact with this application.

Font Reserve System Extension
The Font Reserve Extension, in your Extensions folder inside your System Folder,
allows Font Reserve and other third-party applications to do the following:

• Locate font outline files for printing, screen drawing, and collect for output.

• Automatically activate fonts used in a document.

Note: Although you can use Font Reserve when you start your computer with exten-
sions off, this extension is highly beneficial and should be running whenever possible.

Font Reserve Aliases
For convenient access, the Installer creates aliases for the applications as follows:

Item Alias Location

Font Reserve application In the Startup Items folder*

Font Reserve Settings application In the Control Panels folder

Font Reserve Browser application In the Apple Menu Items folder

DropFont applet On the desktop of the startup volume

DropSet applet On the desktop of the startup volume

*The Font Reserve application’s alias is placed in the Startup Items folder so the data-
base launches automatically when your computer starts up. Since Font Reserve is an
application, rather than an init or an extension, it can run even when you start your
computer with extensions off.
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System Requirements

Since Font Reserve uses Apple Events messages for communication with the database,
the software has some specific system requirements. You can use Font Reserve with any
Macintosh or Power Macintosh computer running Mac OS System 7.5 or greater
including 8, 8.1, and 8.5.

System 7.5+ Requirements
If you’re running System 7.5 or greater, you’re likely to have all the necessary compo-
nents installed and running by default.

• Object Support Lib Extension (installed by default)

• Clipping Extension (installed by default)

• 6 MB RAM that can be allocated to Font Reserve

• 7 MB hard disk space for the Font Reserve applications

System 8.0+ Requirements
If you’re running System 8 or greater, some of the system extensions are built into the
operating system and no longer required.

• 6 MB RAM that can be allocated to Font Reserve

• 7 MB hard disk space for the Font Reserve applications

WorldScript Support
Font Reserve 2.0 supports WorldScript: It will run with any language version of Mac
OS or any Mac OS with a language kit installed. Font Reserve supports the appropriate
default font for the language and renders type correctly (for example, Hebrew text is
rendered from right to left).
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Preparing to Use Font Reserve

To get the best results with Font Reserve, spend a few minutes preparing your system by
disabling other font management software, checking your version of ATM, and moving
fonts out of your System Folder. If you install and enable Font Reserve without taking these
steps, Font Reserve may conflict with other software on your computer.

Disable Other Font Management Software
Running font management programs that allow dynamic font activation along with Font
Reserve can cause system conflicts. Therefore, disable or remove Suitcase, Master Juggler,
and/or ATM Deluxe. You may continue to use font managers that control the display of
application font menus such as TypeTamer, Adobe Type Reunion, or Now Menus.

Check Your Version of ATM
The main function of Adobe Type Manager has always been the smooth rendering of
PostScript fonts on-screen. Since Mac OS does not render PostScript fonts on-screen,
some version of ATM is still required to do this. ATM Deluxe, which includes font
management features, conflicts with Font Reserve. If ATM Deluxe is installed, remove
it from your Controls Panels folder and replace it with the standard version of ATM 4
or an earlier version. (There is no way to disable the “deluxe” features.) 

If you do not have ATM 4, you can install a copy by running the Acrobat Reader
Installer, which is included with Font Reserve. To do so:

1 Remove ATM Deluxe from your Control Panels folder.

2 Restart your computer.

3 Double-click the Reader 3.1 Installer icon. Follow the directions on-screen to install
the software, restarting your computer as prompted.

4 The installer places a copy of ATM 4 inside a folder called “Moved ATM” inside the
Adobe Acrobat 3.1 folder. Drag ATM 4 into your Control Panels folder inside your
System Folder.

5 Restart your computer.

Using Font Reserve — 9

Preparing to Use Font Reserve



Empty the System Fonts Folder
While you can still store fonts in the Fonts folder within your System Folder, those
fonts will not be managed by Font Reserve. We recommend that you move all but your
necessary system fonts out of the System Fonts folder before you begin working with
Font Reserve. You will then add the fonts to Font Reserve according to instructions in
Chapter 4: “Adding and Removing Fonts,” starting on page 41.

Necessary system fonts usually include Charcoal, Chicago, Geneva, and Monaco.
Generally, Symbol and Times should not remain in the System Fonts folder. If you
have any control panels, system extensions, or applications that require specific fonts,
leave those fonts in the Fonts folder as well. For example, the Acrobat Reader requires
that Serif MM and Sans MM remain in the System Fonts Folder.

To remove unnecessary system fonts from the System Fonts folder:

1 Quit all applications. Click your Application Menu in the upper right corner of your
screen and make sure that only Finder is listed.

2 Press Command+N to create a new folder on your desktop. Name the folder some-
thing like “sys fonts.”

3 Open the Fonts folder inside your System Folder.

4 Press Command+A to select all the fonts in the folder.

5 Press the Shift key and deselect the following fonts (if you have them):

• Adobe Serif MM (suitcase) and AdobeSerMM (printer font)

• Adobe Sans MM (suitcase) and AdobeSanMM (printer font)

• Charcoal (suitcase)

• Chicago (suitcase)

• Geneva (suitcase)

• Monaco (suitcase)

Note: If you have a suitcase called “System Fonts,” which includes Charcoal, Chicago,
Monaco and Geneva, leave this suitcase in your System Fonts Folder.

6 Drag the selected fonts into the new “sys fonts” folder on your desktop.

7 Option+click the close box of any open folder to close all the folders.
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Installing and Uninstalling Font Reserve

The Font Reserve Installer application lets you easily install a licensed copy of Font
Reserve or a demonstration version of Font Reserve. The Installer also provides an
“uninstall” option that removes Font Reserve from your computer.

Installing a Licensed Copy of Font Reserve
To get started installing Font Reserve, first quit all applications. Then, locate the Font
Reserve Installer program whether it’s on the CD-ROM or in a folder downloaded
from the web. To install Font Reserve, do the following:

1 Double-click the Font Reserve Installer icon.

2 When the Installer splash screen displays, click Continue.

3 Read the License Agreement. If you agree to the terms of the agreement, click
Accept.

4 Review or print the Read Me notes, then click Continue.

5 Choose Easy Install or Custom Install from the pop-up menu in the upper right
corner. If you choose Custom Install, check the items you want to install.

Tip: Click the Select All button, then uncheck the items you don’t want to install.
For example, if you don’t use QuarkXPress, you can uncheck Quark XTension.

When you select Custom Install, you can check the items you wish to install.
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6 Use the Install Location pop-up menu in the lower left corner to select a location to
install Font Reserve (by default, the root level of the startup drive).

7 Click Install.

8 Enter your name and company when prompted. Click OK.

Enter your name and company to personalize your copy of Font Reserve.

9 Locate your serial number, which is printed on the inside cover of this book or on
the Font Reserve CD-ROM sleeve. Enter your serial number as prompted, then click
OK.

To install Font Reserve in evaluation mode, see “Installing a Demonstration Version
of Font Reserve” on the next page.

Enter your serial number or click Demo in this dialog box.

When the installation is complete, restart your computer to automatically enable Font
Reserve.
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Installing a Demonstration Version of Font Reserve
To install a demonstration version of Font Reserve, follow the instructions for
installing a licensed copy with one exception. In step 9, click Demo rather than enter-
ing a serial number. The demonstration version of Font Reserve will function with the
following limitations:

• You can add only 100 fonts to the database.

• You cannot create additional databases.

• You cannot create other databases, use other databases, or move the database.
You can access only the Font Reserve Database folder at the root level of your start-
up volume.

• You cannot print specimen books.

You can convert the demonstration version to a standard version of Font Reserve by
purchasing a license and entering a valid serial number. To enter the serial number:

1 Quit any applications that are using fonts activated through Font Reserve.

2 Choose Font Reserve Settings from the Control Panels submenu of the Apple
menu.

3 Click Off in the upper left corner of the dialog box.

4 Click Serial Number in the Settings area.

The Serial Number button.

5 Enter the serial number in the field and click OK.

The Serial Number dialog box lets you enter a valid serial number to convert a demonstration
version of Font Reserve to a full-functioning version.

6 Click On in the upper left corner of the dialog box, then click the close box.
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Uninstalling Font Reserve
If you need to remove Font Reserve from your computer for any reason, use the
Uninstaller option provided by the Installer. The Uninstall option automatically
removes all the Font Reserve components from your computer — except for the Font
Reserve Database folder that contains the vault. Since the vault may contain your only
copy of some font files, this folder is not deleted.

Note: If you’re planning to reinstall Font Reserve, export the sets, filters, classes, owners,
and foundries you created and import them for use with the new Font Reserve database.

To uninstall Font Reserve:

1 Locate the Installer program you received with the application.

2 Double-click the Font Reserve Installer icon.

3 Click Continue to bypass the Installer splash screen.

4 Click Accept to bypass the License Agreement.

5 Click Continue to bypass the ReadMe.

6 When the Font Reserve Install dialog box displays, choose Uninstall from the pop-
up menu in the upper right corner.

The Uninstall option in the Font Reserve Install dialog box.

7 Click Uninstall.

The Font Reserve Database folder at the root level of your hard drive contains any
fonts that were stored in the vault. You can access the fonts in this folder or use it to
create another Font Reserve database.
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Chapter 2: Font Reserve Database

Unlike other font management software, Font Reserve consolidates font-related

information into a database that allows you to easily locate, access, and share

fonts. The database consists of three parts: the Font Reserve database application,

the Font Reserve Settings control panel, and the Font Reserve Database folder.

The Font Reserve database application, known simply as Font Reserve, runs in the

background while you’re working. The database application accesses information

in the Font Reserve Database folder to sort, activate, deactivate, copy, and delete

font files according to your needs. The Font Reserve Settings control panel provides

an interface for the Font Reserve database application. The Font Reserve Data-

base folder contains the database catalog files that store information about your

font files; the folder also stores the physical font files you choose to keep in the Font

Reserve vault.

The Font Reserve database is designed for maximum flexibility. If your database

is too large to keep on your computer, you can move it to another volume. Or, you

can create two databases of fonts and choose the one you wish to use. In work-

group environments, you can create a master Font Reserve database and copy it to

other users on the network so everyone has an identical font library. Since the

Font Reserve database may contain your only copy of some fonts, or represent a

fair amount of your time, you can create backups of it.
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Font Reserve Settings Interface

The Font Reserve Settings control panel lets you turn Font Reserve on and off, enable
automatic font activation, specify the location of the Font Reserve Database folder,
change your serial number, specify the memory partition for Font Reserve, and display
a log of errors and activity. If you have questions about any controls in Font Reserve
Settings, check this section.

Opening Font Reserve Settings
To open the Font Reserve Settings control panel, double-click the icon in the Font
Reserve 2.0 Folder or select the alias from the Control Panels submenu of the Apple
menu.

The Font Reserve Settings control panel.

On/Off and Startup Controls
The On/Off radio buttons and the Turn on when Mac restarted check box let you
control when Font Reserve is running. Remember, since Font Reserve is an application
and not a system extension, you can turn it on and off without restarting your com-
puter, and you can use it when you start your computer with extensions off.
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The On/Off controls in the Font Reserve Settings control panel.

• The On button launches Font Reserve in the background. Ideally, Font Reserve
should remain on the entire time your system is running. However, some Font
Reserve functions require you to turn Font Reserve off.

• The Off button sends an Apple Events message that quits Font Reserve. When you
turn Font Reserve off, any active fonts are deactivated and you cannot launch the
Font Reserve Browser.

• When checked, Turn on when Mac restarted places an alias to Font Reserve in the
Startup Items folder inside the System Folder. Each time you start up your comput-
er, the database launches automatically.

Auto-Activation Area
The Auto-Activation area lets you control whether Font Reserve automatically acti-
vates fonts used in documents. When Activate fonts automatically is checked, Font
Reserve activates fonts required by documents that you open, as long as they’re avail-
able. The Auto-Activation feature works with most applications, with the notable
exceptions of Illustrator and PageMaker. See “Activating Document Fonts
Automatically” on page 73 for more information.

The Auto-Activation area in the Font Reserve Settings control panel.

In applications that are able to dynamically update their font menus — such as Freehand,
Framemaker, and QuarkXPress — auto-activated fonts display in the font menus and can
be applied to text. In applications that are unable to dynamically update their font menus
— such as Microsoft Word and FileMaker Pro — auto-activated fonts display on-screen
and print correctly, but are not listed in font menus. To update the font menus in order to
apply the auto-activated fonts to text, relaunch the application.

Note: If the Font Reserve system extension is not running, the Auto-Activation feature
is gray and unavailable.
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Database Area
The Database area lets you create additional Font Reserve Database folders and select
the one you want to use. Or, if you have limited hard drive space, you can move your
Font Reserve Database folder to another volume and select it. To make changes to the
Font Reserve Database folder, you need to quit any applications using active fonts and
turn off Font Reserve.

The Database area in the Font Reserve Settings control panel.

• The Folder pop-up menu displays the path to the Font Reserve Database folder on
the current volume (which is indicated in the Volume field).

• The Server and Zone fields display the location of the volume if it resides on a net-
worked server. If the Font Reserve Database folder is moved to a volume on a net-
worked server, that volume must be available when you launch Font Reserve. If Font
Reserve is launching automatically, the Font Reserve Database folder should be
stored on a startup volume.

• The New button, which is available only when Font Reserve is Off, lets you create
and name additional Font Reserve Database folders. Enter a name for the folder,
select a location for it, and click Save.

The New button lets you create a new Font Reserve Database folder.
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• The Select button, which is available only when Font Reserve is Off, displays a stan-
dard directory dialog box which lets you select the Font Reserve Database folder you
want to use. Navigate to the folder, select it, and click Select “name of folder.”

The Select button lets you locate and select a different Font Reserve Database folder.

Settings Area
The Settings area lets you view and enter your serial number and change the amount
of memory allocated to Font Reserve.

The Settings area in the Font Reserve Settings dialog box.

• The Serial Number button displays a dialog box that lets you view and change your
serial number. You might use this for three reasons: To access your serial number to
reinstall or upgrade Font Reserve; to “unlock” a demo version after purchasing a full
product; or to change a serial number from a single-user license to a multi-user
license.

The Serial Number dialog box lets you assign a different serial number to Font Reserve.
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• The Memory button displays the Memory Requirements dialog box, which lets you
change the amount of memory allocated to Font Reserve. If the number of fonts in
your database approaches 3,000, you can improve performance by increasing the
memory partition from the minimum 2.5 MB.

The Memory Requirements dialog box lets you change the memory allocated to Font Reserve.

Diagnostics Area
The Diagnostics area reports Font Reserve errors according to your needs.

The Diagnostics area in the Font Reserve Settings dialog box.

• The Last Error button displays the last problem encountered by Font Reserve. For
example, if you cannot add a font, the Last Error button tells you why.

• The Log button displays the Activity Log — a complete record of program activi-
ties, including startups, font additions, and errors. You can print the log, export it to
a file, and clear it.

The Activity Log dialog box lists when Font Reserve starts up, shuts down, and encounters errors.
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Enabling and Disabling Font Reserve

Several database management tasks require you to disable Font Reserve. If you restart-
ed your computer after installation, Font Reserve is enabled by default. Use these steps
any time you need to enable or disable Font Reserve.

1 If you’re turning Font Reserve off, quit any applications that are using fonts activat-
ed through Font Reserve.

2 Open the Font Reserve Settings control panel.

3 Click On (or Off) in the upper left corner of the dialog box.

4 Check Turn on when Mac restarted to specify that restarting your computer always
restarts Font Reserve. Uncheck this box if you want Font Reserve to remain off until
you turn it back on.

Use the On/Off buttons in the Font Reserve Settings control panel to enable and disable it.

5 Click the close box to save your changes.
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Changing the Memory Partition

The Font Reserve database requires approximately 2.5 MB of RAM to operate correctly,
independent of the number of fonts you have in your database. Although the minimum
memory partition can handle 10,000 or more fonts, once you get to about 3,000 fonts
you can improve performance greatly by increasing the memory partition.

To increase (or decrease) the memory partition for Font Reserve:

1 Quit any applications that are using fonts activated through Font Reserve.

2 Open the Font Reserve control panel.

3 Click Off in the upper left corner of the dialog box.

4 Click Memory in the Settings area.

The Memory button lets you increase Font Reserve’s memory partition.

5 Enter the amount of RAM to allocate to Font Reserve in the Preferred Size field.

The Preferred Size field lets you specify the amount of RAM to allocate to Font Reserve.

6 Click OK.

7 Click On in the upper left corner of the dialog box.

8 Click the close box to save your changes.

Tip: If you’re planning to add a great deal of fonts at one time, from a CD-ROM of
fonts for example, you may want to increase the memory partition, add the fonts, then
decrease the memory partition again.
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Moving the Database

Depending on how many fonts you add to Font Reserve, and how many fonts you
store in the vault, your Font Reserve Database folder may become very large. You can
move the Font Reserve Database folder to another volume if necessary, as long as that
volume is available on startup.

To move the Font Reserve Database folder:

1 Quit any applications that are using fonts activated through Font Reserve.

2 Open the Font Reserve Settings control panel.

3 Click Off in the upper left corner of the dialog box.

4 At the Finder, move your Font Reserve Database folder to another location. Make
sure you choose a shared startup volume so the Font Reserve application can find
the data when your computer starts up.

5 In the Font Reserve Settings control panel’s Database area, click Select. Use the
directory dialog box to navigate to the Font Reserve Database folder’s new location,
then click Select.

Use the Select button in the Database area to move the Font Reserve Database folder.

6 Click the close box to save your changes.
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Creating Multiple Databases

You may wish to have more than one Font Reserve database. For example, if users work
different shifts on the same computer, they may wish to have their own database. Or, a
service bureau may have one database for their own fonts and a separate database for
their clients’ fonts. Font Reserve can access only one database at a time.

To create a new database:

1 Quit any applications that are using fonts activated through Font Reserve.

2 Open the Font Reserve Settings control panel.

3 Click Off in the upper left corner of the dialog box.

4 In the Database area, click New.

5 Use the directory dialog box to specify a name and location for the new Font Reserve
Database folder, then click Save. The new database is automatically selected.

Use the New button in the Database area to create a separate Font Reserve Database folder.

6 Click the close box to save your changes.

The new Font Reserve Database folder is empty. Add fonts to this database using any
techniques you prefer. Font Reserve will continue to use this database until you select
another database. Once you have multiple databases, you can switch among them by
turning off Font Reserve and using the Select button in the Font Reserve Settings
control panel.
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Sharing Copies of the Database

In a workgroup environment, where it’s often important that all the users have pre-
cisely the same fonts, you may wish to share copies of the Font Reserve database.
(Remember, fonts are subject to license agreements and should not be shared and
used indiscriminately.)

Multiple users cannot share the same database, so you need to create copies of your
database manually. Use standard Finder techniques to copy and distribute the database
to other users. Members of your workgroup should then use the Select button in the
Font Reserve control panel to specify the database you created.

You can share copies of the database if your fonts are in the vault or accessible on a
networked server.

Sharing Fonts in the Vault
If the fonts you want to share are in the vault, copies of the database contain copies
of all your font files. If your database changes, you’ll need to distribute new copies of
the database. This is the best way to share a database of fonts if your workgroup is
not networked.

Note: If the database you copy contains font aliases, the aliases point to fonts on your
computer. To share those fonts, you will need to share your computer with other users
and the other users will need to mount your hard drive.

Sharing Fonts on a Server
If the fonts you want to share are on a server, you can create a database of font aliases
that point to the fonts on the server. To do this, add the fonts from the server using the
alias method. When the users access fonts in the database, they are actually accessing
fonts on the server.
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Backing Up the Database

If all your fonts are in the vault — or if you’ve invested a great deal of time in compil-
ing your database — you may wish to back it up. To do this, simply create a copy of
the Font Reserve Database folder at the Finder. You might burn a CD-ROM containing
the folder or store the folder on a ZIP drive or another volume. If the Font Reserve
Database folder is too large to backup, you can maintain your sets and other cus-
tomization by backing up the Catalog folder.

If one of your font files is corrupted, if your Catalog becomes corrupt, or if your entire
system crashes, you can easily recover using the backup.

• To replace a corrupt font, first use the Browser to delete it. Then, locate the font files
in your backup of the vault. Add the backup copies to Font Reserve through the
Browser.

• To replace a corrupt Catalog, turn off Font Reserve and copy the backup Catalog
into the Font Reserve Database folder. The backup of the Catalog will be able to find
all the fonts in the vault and find the fonts that font references point to — provided
that you haven’t deleted or moved any fonts since the backup was created.

• To recover from a system crash, reinstall Font Reserve. Copy your backup of the
Font Reserve Database folder to your computer, then use the Select button in the
Font Reserve Settings control panel to specify it as the active database.
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Chapter 3: Browser Interface

The Font Reserve Browser application consists of a full-featured dialog box, various

menus, and a complex preferences dialog box. The Font Reserve Browser interface

is designed to mimic the Mac OS as much as possible. If you’re not sure how to

accomplish a task, try the method you would use at the Finder. For example, you

can Shift+click or marquee to select multiple fonts in the Font Reserve Browser.

Once you work with Font Reserve, you’ll quickly become familiar with its com-

mands and controls. This chapter provides an overview and “what is it” informa-

tion about the interface controls in the Font Reserve Browser. For “how to do it”

information, consult the remaining chapters in this book.
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Font Reserve Browser

The main dialog box of the Font Reserve Browser application provides your font
management tools. (This dialog box is simply referred to as the Browser hereafter.)
You use the Browser to add, delete, activate, and deactivate fonts; to preview, print,
and sort fonts; to assign classes and owners to fonts; and to group fonts into sets for
specific projects.

To open the Browser, double-click the Font Reserve Browser icon in the Font Reserve
2.0 Folder or select the alias from the Apple menu.

The main dialog box of the Browser application.

The Browser has the following characteristics:

• Fonts that reside in the vault are displayed in roman type. Fonts that reside outside
the vault are italicized (the same way aliases are italicized at the Finder). See
“Methods for Adding Fonts” on page 42.

• You can select items as you would at the Finder: Click in a line to select an item,
Shift+click to select multiple items, and marquee to select a range of continuous
items.
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• Full drag-and-drop support allows you to drag files and folders into and out of the
Fonts and Sets areas of the Browser. For example, you can drag volumes, folders, and
files to the Sets or Fonts area of the Browser to add the fonts to Font Reserve.

• Unlike the Finder, dragging files out of the Browser does not move or delete the
fonts — it simply copies the fonts to the new location.

Font Management Buttons
The top of the Browser provides buttons for managing fonts and sets. The New, Filter,
and Import buttons are always available, while the remaining buttons are active when
you select fonts or sets in the Browser.

Buttons in the Browser.

The font management buttons work as follows:

• Perm: Clicking Perm activates selected fonts or sets permanently; the fonts
remain active until you deactivate them.

• Temp: Clicking Temp activates selected fonts or sets temporarily; the fonts
remain active until you shut down your computer or until you deactivate them.

• Deact: Clicking Deact deactivates selected fonts or sets; the fonts remain inac-
tive until you activate them.

• Preview: Clicking Preview displays Previews for all selected fonts, including
each font within selected sets.

• New: Clicking New creates a new, untitled set. The name is highlighted auto-
matically so you can enter a name for the new set.

• Filter: Clicking Filter opens the Quick Filter Editor dialog box, which lets you
specify the fonts to display in the Browser using a combination of criteria such as
name, foundry, and version.
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• Delete: Clicking Delete has a different effect depending on the selected items:
sets, font references within sets, font aliases, or fonts that reside in the vault.

Deleting a set simply deletes the folder containing the references to the fonts; it does
not delete fonts from Font Reserve or from your computer. Deleting a font reference
removes the font reference from its set; it does not delete fonts. Deleting a font alias
(an italicized font) deletes the font from Font Reserve, but not from your computer.
Deleting a font that resides in the vault deletes the physical font files.

• Import: Clicking Import displays a directory dialog box, which lets you locate
and select set information exported by other Font Reserve users. The imported sets
consist of font references, which will attempt to locate fonts in your database.

• Export: Clicking Export lets you export selected sets; you can share the sets with
other users who have the same fonts in their database. Use the directory dialog box
to create a new folder for the exported set information.

Common Attributes of the Sets and Fonts Areas
The Browser is divided into two primary areas: Sets and Fonts. When you click in one
of the areas, it becomes active and you can begin manipulating fonts within it. Each
area provides a resize box and scroll bar so you can display as much or as little of it as
you wish. The Sets and Fonts areas have the following in common:

• To activate and deactivate fonts and sets, select them and click the appropriate but-
ton at the top of the Browser: Perm, Temp, or Deact.

• To toggle fonts and sets between active and inactive, click the round button to the
left of the font or set name. Depending on your setting in the Activation panel of
the Preferences dialog box (Edit menu), the button toggles between active perma-
nently and inactive, or active temporarily and inactive.

The round buttons to the left of font and set names let you toggle fonts active and inactive. In this
example, Stone Serif is active and StoneInformal and StoneSans are inactive.
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• To determine the status of a font or set, check the state of its button: a black circle
means all the fonts are active permanently, gray means active temporarily, and white
means inactive. If the fonts are in different states, multiple icons display.

The Letterhead set includes fonts that are active permanently, active temporarily, and inactive.

• To display a menu that lets you activate, deactivate, or preview fonts, Control+click
any font, font reference, font alias, set, family, or suitcase in the Browser.

• To change the columns of information (name, kind, class, foundry, etc.) displayed in
the Sets and Fonts areas, use the Columns panel of the Preferences dialog box (Edit
menu). The Sets and Fonts areas always display the same columns.

• To control the sorting order of fonts in the active area, choose an option from the
Sort List submenu of the View menu: by Active, by Name, by Kind, etc. The Sort
List options vary according to the columns you choose to display. For example, if
the Family column is displayed, you will have a by Family option in the Sort List
submenu of the View menu.

• You can also control the sorting order by clicking the name of a column (for exam-
ple, clicking Name in the Fonts area sorts the list by font name).

• To display the fonts in a set, family, or suitcase individually, click the triangle to the
left of the name.

Sets Area
Font Reserve allows you to group fonts into “sets” that can be manipulated as one unit.
For example, if your letterhead contains five different fonts, you can create a set for
those fonts and activate and deactivate them as necessary. The Sets area of the Browser
displays all the sets you create.
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Sets consist of pointers to fonts — called font references — within the Font Reserve
database. Since they are simply pointers, you can move, copy, and delete font refer-
ences within sets without creating additional font files or deleting font files. Sets
consume very little hard disk space so you can create as many as you need without
causing problems.

The Sets area at the top of the Browser.

When the Sets area is highlighted, it works as follows:

• To create a new set, click the New button, press Command+N, or choose File ➛
New Set.

• To add a font to a set, select it in the Fonts area and drag it into the set folder.

• To move a font from one set to another, select it and drag it to another set folder.

• To copy a font from one set into another, select it and press the Option key while
you drag it to another set folder.

• To place a set inside another set, select it drag it to another set folder.

• To place a copy of a set inside another set, select it and press the Option key while
you drag it to another set folder.

• To delete a font reference from a set, select it and click the Delete button.

• To delete a set, which deletes only the folder and the font references, select it and
click the Delete button.

• To delete a set and delete its fonts from Font Reserve, press Command+Shift while
you click the Delete button. If the fonts reside in the vault, the physical font files
will be deleted.
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Fonts Area
The Fonts area lists all the fonts in Font Reserve; if you choose Filter ➛ Show System
Fonts, the Fonts area will list all the fonts in your System Fonts folder as well. Fonts
that reside in the vault are displayed in roman type; fonts added via the alias method
are displayed in italic type. You can group fonts by family, group fonts by suitcase, sort
fonts in various ways, and specify which fonts to display.

The Fonts area at the bottom of the Browser.

When the Fonts area is highlighted, it works as follows:

• To display fonts that start with a specific letter, check the box next to the alphabet
strip. Click to select a letter, Command+click to select multiple letters, and
Shift+click to select a range of continuous letters.

• To select a specific font (when fonts are not grouped by family or suitcase), type the
first few characters of the font name. When the dialog box displays, click Jump or
press Return/Enter.

The Jump to... dialog box lets you quickly locate a font.

• To specify which fonts display, use the Filter controls: the Filter button on the
Browser, the preset options in the Filter menu, and the Edit Quick Filter dialog box.
To display all your fonts again, choose Filter ➛ None.

• To combine all the fonts in a family into a group, choose View ➛ Grouped by
Family. To open a family group, click the triangle next to it.
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• To display font families according to their suitcases, choose View ➛ Grouped by
Suitcase. To open a suitcase, click the triangle next to it.

• For a quick preview of a font, Command+click the icon to the left of its name. To
customize the size and text in the quick preview, use the Previews panel of the
Preferences dialog box (Edit menu).

• To determine how many fonts are listed in the Fonts area, look at the field in the
lower left corner of the Browser. The field shows the number of fonts listed, fol-
lowed by the total number of fonts in the database, followed by the name of the
current filter in use, and a list of the current alphabetical indices in use.

The field in the lower left corner indicates which fonts are displayed.

Icons in the Browser
The Browser displays a unique icon for each type of item and font. The icons represent
the following:

• The Folder icon indicates a set, which consists of references to fonts in the Font
Reserve database.

• The Family icon indicates that fonts are currently combined into families
(View ➛ Grouped by Family).

• The Suitcase icon indicates that fonts are currently combined into suitcases
(View ➛ Grouped by Suitcase).

• A Padlock icon next to a font’s icon indicates locked fonts, which cannot be activat-
ed, deactivated, or deleted through Font Reserve. Locked sets cannot be renamed.

• The PS Pair icon indicates a healthy PostScript font. This single icon represents
both the printer outline and the screen components of the PostScript font.

• The Bitmap icon indicates a screen font only. Also known as an Orphan Bitmap,
this represents a screen font for which no printer outline font component is avail-
able within Font Reserve.
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• The PS Outline icon indicates a printer outline font only. Also known as an
Orphan Outline, this represents a printer outline font for which no screen font
component is available within Font Reserve.

• The TrueType icon indicates a healthy TrueType font. The various styles of the
font are not shown in the Browser or in the Preview, but are available when the font
is active.

• The TrueType GX icon indicates a TrueType GX font.

• The TypeOne GX icon indicates a TypeOne GX font.

• The PS MM icon indicates a healthy PostScript Multiple Master font. This single
icon represents the printer outline component and the various screen components
of the Multiple Master font. The various instances of the Multiple Master font are
not shown in the Browser or in the Preview, but are available when the font is
active.

• The PS Outline (MM) icon indicates a multiple master printer outline font only,
for which no corresponding screen font components are available within Font
Reserve.

• The PS Pair (3) icon indicates a healthy PostScript Type 3 Font. This single icon
represents both the printer outline and the corresponding screen bitmap compo-
nents of the PostScript Type 3 font.

• The PS Outline (3) icon indicates a Type 3 printer outline font only, for which
no corresponding screen font component is available within Font Reserve.
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Font Reserve Browser Menus

While basic font management tasks are accomplished through the Browser, the Font
Reserve Browser application’s menus provide sophisticated font management options.
For example, in the menus you’ll find options that let you classify fonts according to
their design and assign owners to fonts to keep track of who they belong to. For specif-
ic information about any menu command, consult the index.

The Font Reserve Browser application’s menus.

File Menu
Use the File menu to create new sets, close the active window, update your System
Fonts set, display a log of Font Reserve activity and errors, print reports from Font
Reserve, and quit the Font Reserve Browser application.

Edit Menu
Use the Edit menu to cut, copy, paste, and delete text (useful for naming sets); select
everything listed in the Sets or Fonts area; activate and deactivate fonts; and open the
Preferences dialog box. The Preferences dialog box provides important options for
adding fonts, activating fonts, viewing information in the Browser, and previewing fonts.

The File menu and Edit menu.
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View Menu
Use the View menu to sort fonts, group fonts, and display previews. The Sort List sub-
menu provides sorting options such as by Name and by Foundry, which vary accord-
ing to the columns of information displayed in the Browser. The middle portion of the
menu lets you group fonts by family or suitcase, and ungroup fonts to list them indi-
vidually. The lower portion of the menu lets you display a specific panel of the
Preview for selected fonts.

Class Menu
Use the Class menu to categorize fonts according to their design (modern, sans serif,
script, ornamental, etc.). When Font Reserve adds fonts, it attempts to determine their
design and classifies them automatically. You can change a font’s class, remove its class,
revert to the class assigned by Font Reserve, and customize the list of classes.

Filter Menu
Use the Filter menu to find and display only certain fonts — for example, you can dis-
play only PostScript fonts or only the fonts in the vault. The menu provides a variety of
default filters such as Active Fonts and In Vault, a Quick Filter similar to the Finder’s
Find dialog box, options for editing the default filters, and options for creating custom
filters. The Filter menu also provides a Show System Fonts command, which controls
whether fonts in the System Fonts folder are displayed in the Browser.

The View menu, Class menu, and Filter menu.
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Owner Menu
Use the Owner menu to create a list of font owners, edit that list, and assign owner-
ship to fonts. The bottom portion of the menu lists all the names you specify in the
Owners dialog box.

Foundry Menu
Use the Foundry menu to customize the list of font foundries and change the foundry
specified for a font. When Font Reserve adds fonts, it assigns a foundry from the default
list. If a font’s foundry is not included in the list, or Font Reserve cannot determine the
foundry, you can add the foundry to the list and assign it to the appropriate fonts.

Specimen Menu
Use the Specimen menu to print a type book from selected fonts. The menu lets you
select and customize the template used for the book.

The Owner menu, Foundry menu, and Specimen menu.

Window Menu
Use the Window menu to resize or display an open window. The top portion of the
Window menu, which lists all open windows, is useful when a variety of Previews are
open. The Zoom Window command resizes the active window.

Font Menu
Use the Font menu to quickly determine which fonts are active on your computer
(including fonts in the System Fonts folder). The Font menu displays only if you check
Show “Font” menu in menubar in the Columns panel of the Preferences dialog box
(Edit menu).

The Window menu and the Font menu.
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Font Reserve Browser Preferences

The Preferences dialog box lets you customize the way fonts are added to Font
Reserve, the way fonts activate when you toggle them, the columns of information
displayed in the Browser, and the size and text used for previewing fonts.

The Font Reserve Browser application’s Preferences dialog box.

The Preferences dialog box works as follows:

• To open the Preferences dialog box, choose Edit ➛ Preferences or press
Command+; (semicolon).

• To specify which panel of preferences to display, click one of the icons in the scroll
bar at left.

• To view information about a control, click the help button to the right of it.

• To revert a panel to the default settings, click Use Defaults. This button is panel-
specific; it will not revert preferences in the entire dialog box to defaults.

• To close the dialog box without saving changes made in any panel, click Cancel.

• To close the dialog box and save all the changes, click OK.
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The Preferences dialog box provides the following panels:

• Activation: Use this panel to specify whether fonts activate temporarily or perma-
nently when you toggle them, whether the original font activates or a copy of it, and
how font name conflicts are handled.

• Adding Fonts: Use this panel to specify how font files are handled when you add
fonts to Font Reserve and to specify the default owner of fonts.

• Character Map: Use this panel to specify a default point size for characters in the
Character Map panel of the Preview dialog box.

• Columns: Use this panel to select the information (family, foundry, kind, etc.) you
want to display in the Sets and Fonts areas of the Browser, to specify whether fonts
are listed according to menu name or PostScript name, and to specify whether the
Font menu displays in the Font Reserve Browser application.

• Paragraph: Use this panel to customize the size, leading, and text used in the
Paragraph panel of the Preview dialog box. You can also customize the width of the
Paragraph panel.

• Previews: Use this panel to specify the default panel displayed in the Preview dialog
box, and to specify the point size and text for quick previews obtained by
Command+clicking a font in the Browser.

The Previews panel of the Preferences dialog box.

• Sample: Use this panel to edit the text and specify the point size used in the Sample
panel of the Preview dialog box. You can also customize the width of the Sample
panel.

• Waterfall: Use this panel to edit the text used in the Waterfall panel of the Preview
dialog box.
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Chapter 4: Adding and Removing Fonts

Whether you’re working with an entire CD-ROM of fonts, all the fonts on your

hard drive, a new font downloaded from the web, or a single font you need for 

a quick print job, there’s a convenient method for adding fonts to Font Reserve.

A few preferences affect the way fonts are added, and you can add fonts via the

Browser window, the DropFont applet, or the DropSet applet.

A side benefit to adding fonts to Font Reserve is the diagnostics information you

receive: you’ll be able to quickly determine if any of your font files are corrupt, or

if you’re missing a PostScript font’s bitmap or outline file. With this information,

you can rid your computer of unusable fonts.

Font Reserve provides equally convenient methods for getting fonts out of Font

Reserve. If you’re only going to use a font once, you can add it “temporarily” so it’s

removed the next time you launch Font Reserve. You can remove other fonts via

the Browser window, and you can export fonts for delivery to a service bureau.
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Methods for Adding Fonts

You can add fonts to Font Reserve in two ways — the vault method or the alias
method. The primary difference is that the vault method moves your font files to a
single location while the alias method leaves fonts in their current location.

You can use the vault method and the alias method interchangeably, depending on
your needs. Regardless of how you add fonts, and where the fonts are stored, you can
manage all your fonts with the Font Reserve Browser.

The Vault Method
When you add fonts using the vault method, Font Reserve places the physical font files
in a centralized place called the vault. By default, the vault is located inside the Font
Reserve Database folder at the root level of your hard drive. You have the option to
move font files into the vault or copy font files into the vault.

Using the vault method offers several advantages over the alias method:

• Your fonts are automatically organized into a clean, hierarchical structure

• You are prevented from adding duplicate fonts

• The fonts are always available on your computer

The vault method is suited to users who own all their own fonts and prefer keeping
them in one location. For example, freelance graphic designers may prefer to use the
vault method.

Within the vault, fonts are organized into hierarchical folders as follows:

• Type (first level): At the top level of the vault, fonts are organized by type.

• Foundry (second level): Within each type’s folder, the fonts are organized by font
foundry.

• Family (third level): Inside each font foundry folder, fonts are organized by family.

• Version Number (fourth level): Inside each font family folder, fonts are organized
according to version number.

• Physical Font Files (fifth level): The physical font files, including suitcases and
PostScript printer fonts, are inside the version number folders.
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The five levels of hierarchy within the Vault folder.

The Alias Method
If you’re familiar with programs like Suitcase, Master Juggler, or ATM Deluxe, then this
method will be familiar to you. When you add fonts using the alias method, the original
font files remain in their current location, and are not modified in any way. Font Reserve
simply keeps an alias to the original font files in the database.

Fonts added via the alias method are displayed in italics in the Browser, and are available
only when the volume containing the fonts is available. For example, if you add fonts
from a ZIP disk via the alias method, the ZIP disk must be available in order for you to
use those fonts. When adding fonts via the alias method, you can choose to add them
temporarily. Fonts that are added temporarily are removed from your database when
you shut down your computer.

The alias method is especially suited to service bureaus and printers that need to man-
age fonts from a variety of clients. With the alias method, service bureaus do not need
to install each clients’ fonts on their computer — Font Reserve can access the fonts on
a ZIP or floppy disk. The alias method is also convenient if you’re in the habit of stor-
ing fonts with specific jobs. For example, if you have a folder on your hard drive that
contains a document, all the graphic files, and all the fonts for a brochure, you may
want to keep the fonts there. In this case, you might want to use the alias method to
add the fonts.
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Adding Fonts to Font Reserve

Although adding fonts to Font Reserve is as easy as drag-and-drop, understanding
exactly what’s happening is a little more complex. When you add fonts, you need to
know whether you’re adding those particular fonts via the vault method or the alias
method. With the vault method, your physical font files are stored in the vault; with
the alias method, an alias to the fonts is placed in the database and your physical font
files remain untouched. To specify the method for adding fonts, you can set a prefer-
ence in advance — and you can change the setting each time you add fonts.

Setting Preferences for Adding Fonts
To specify whether fonts are added via the vault method or the alias method when
adding fonts through the Browser, use the Adding Fonts panel of the Preferences
dialog box. The DropFont and DropSet applet each have their own preferences dialog
box, which offers the same options for adding fonts.

1 Choose Preferences from the Edit menu.

2 Click the Adding Fonts icon in the scroll bar at left.

The Adding Fonts panel of the Preferences dialog box.
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3 To specify the vault method, click one of the Font Files buttons:

• Move into Vault: Moves physical font files from any location, including a remote
volume or ZIP disk, into the vault. (Fonts on CD-ROMs or locked disks are
copied into the vault.) Organizations such as design studios, which allow each of
their designers to store and manage all their fonts on their local workstations, may
prefer this setting.

• Copy into Vault: Copies physical font files into the vault, leaving the originals
untouched. If you want to load all your font files into Font Reserve, then delete the
originals after you’ve begun working the program more, this setting works well.

Note: To experiment with Font Reserve in evaluation mode, Copy into Vault is the
best option.

• Leave in place (alias method): Stores an alias for each font file in the database cat-
alog — not the vault — and the physical font files remain untouched.

The alias method has the following affect on font files: If you delete an alias from
the Browser, the physical font file is unaffected. If you delete a physical font file, its
corresponding alias remains in the database. If you attempt to activate the alias,
Font Reserve notifies you that the font file does not exist and that you should
delete the alias from the database. If you move a physical font file within the same
volume, the alias will be able to locate the font.

The alias method works well for accessing fonts stored on a CD-ROM or server. In
environments such as printers and service bureaus, in which users may not want
duplicate fonts on each workstation, the alias method works well.

4 If you want to change your adding fonts preference each time you drag a font into
the Browser, check Always open this window. If you plan to use only one method
consistently, set your preference and uncheck Always open this window.

5 Click OK to implement you changes.

You need to set this preference individually for the DropFont or DropSet applet. To do
so, double-click the applet, then choose Edit ➛ Preferences. Change the setting, click
OK, then choose File ➛ Quit.
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Adding Fonts and Font Sets via Drag-and-Drop
To add fonts to Font Reserve, select the volumes, folders, and files containing the fonts
at the Finder. The items you select don’t have to contain fonts exclusively — if your
fonts are spread throughout your entire hard drive, simply select your hard drive icon.
You can drag-and-drop your selection into the Fonts or Sets area of the Browser, or
onto the DropFont applet or DropSet applet.

• To add fonts individually, drop your selection onto the Fonts area of the Browser or
onto the DropFont applet. The fonts will be listed in the Fonts area.

• To add fonts as sets, drop your selection onto the Sets area of the Browser or onto
the DropSet applet. The fonts are added to the list in the Fonts area, and each vol-
ume or folder becomes a set. The sets consist of references to the fonts, rather than
copies of the fonts.

Tip: The applets provide a quick method for adding fonts without having to open the
Browser. If you’re just adding fonts, you can skip launching the Browser.

Once you drop your selection, the Adding Fonts panel of the Preferences dialog box
may display so you can specify whether the fonts are added via the vault method or
the alias method. If the dialog box displays, see the “Specifying the Vault Method or
Alias Method On-the-Fly” section on the next page. If it does not display, the fonts are
added according to your preference setting; continue to the “Scanning Fonts” section
on the next page.

Adding Fonts Via the Scan Folder Command
Rather than switching to the Finder and dragging icons, you can add fonts to the Fonts
area using the Scan Folder command in the File menu. Use the Choose a folder to scan
dialog box to locate and select a folder of fonts, then click Select.

The Scan Folder command in the File menu lets you select a folder of fonts to add.
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Specifying the Vault Method or Alias Method On-the-Fly
When you add fonts to Font Reserve, the following Preferences dialog box displays 
if Always open this window is checked. The Browser, the DropFont applet, and the
DropSet applet each have their own Preferences dialog box, which remembers its
own settings.

The condensed Preferences dialog box, which displays when Always open this window is checked
for the Browser, the DropFont applet, or the DropSet applet.

Move into Vault and Copy into Vault are variations of the vault method, while Leave
in place specifies the alias method. For specific information about the options, see
“Setting Preferences for Adding Fonts” on page 44.

Click an option, then click OK to continue adding the fonts. If you do not want the
Preferences dialog box to display each time you add fonts, be sure to uncheck Always
open this window. Once you click OK, Font Reserve starts scanning your fonts.

Note: If you’re adding fonts from a client, you may wish to specify an owner when you
add the fonts. See “Working with Owners” on page 127.

Scanning Fonts
Once you drag-and-drop your selection to start adding fonts, Font Reserve begins a
scanning process that finds, examines, and organizes all your fonts. The Font Reserve
Scanner dialog box shows the progress of the scan, which is divided into the four
phases described briefly below.
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When you’re adding fonts, the Font Reserve Scanner dialog box shows the progress of the scan.

The amount of time the scan takes depends on a variety of factors, including: the
number of fonts you’re adding, the speed of your computer, the media the fonts are
stored on, whether you’re working over a network, and the amount of memory allo-
cated to Font Reserve. In general, adding 2,000 fonts will take from 15-30 minutes.

The Font Reserve Scanner phases work as follows:

• The Scan phase locates every font file — including suitcases, bitmaps, outlines,
etc. — within your selection.

• The Check phase analyzes each font for corruption.

• The Add phase opens each font file’s resource, extracts information such as the
foundry name and version number, and adds the information to the database. If
you’re adding fonts via the vault method, the Add phase checks for duplicate fonts
and moves or copies the fonts to the vault.

• The Match phase matches all the screen bitmap files with their corresponding print-
er outline files.

Pausing or Stopping the Font Reserve Scanner
During the last three phases of scanning — Check, Add, and Match — the Pause and
Stop buttons are available in the Font Reserve Scanner dialog box.

• Click the Pause button if you need to interrupt the scan and perform another task
on your computer. When you’re finished with the other task, click Continue.

• Click the Stop button if you decide you no longer want to continue adding the
selected fonts to Font Reserve. The Stop button does not cancel the operation; it
simply stops adding fonts when you click it.

There is no danger of losing or corrupting fonts when you click Pause or Stop. Since
Font Reserve is making changes to your system during the last three phases of the
scan, the scanner will complete its current operation before pausing or stopping.
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Adding Fonts Temporarily

If you need to use a font, but you don’t want to add it to your database permanently,
you can add the font temporarily using a variation of the alias method. When you add
fonts temporarily, aliases to the fonts are placed in the database then removed when
you quit Font Reserve or shut down your computer.

Adding fonts temporarily works well for processing small jobs at service bureaus:

• Say a client needs a color proof and supplies a ZIP disk containing the document,
graphics, and fonts.

• You can add the fonts temporarily and print the document using the graphics and
fonts on the ZIP disk.

• By the time the computer is shut down and the fonts are removed from the data-
base, the client has left with their color proof.

Adding fonts temporarily may not work well for jobs that take several days because
the computer may be shut down.

Specifying the Add Temporarily Preference
To add fonts temporarily, use one of the drag-and-drop options or the Scan Folder
command as described on page 46.

When the Preferences dialog box displays, you need to change a setting to specify that
the fonts are temporary. If you have Always open this window unchecked, confirm your
setting in the Preferences dialog box before attempting to add fonts temporarily or press
the Command key while you drag the fonts to open the Preferences dialog box. In the
Preferences dialog box, change the following settings to add fonts temporarily:

1 In the Font Files area, click Leave in place. This specifies the alias method so the
fonts are not placed in the vault.

2 In the Expert Options area, check Add temporarily.

Note: See “Adding Fonts and Activating them Simultaneously” on page 51 for infor-
mation about the other Expert Options: Deactivate all temp active fonts and
Activate added fonts temporarily.
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The Expert Options area of the Preferences dialog box lets you add fonts temporarily.

3 Click OK.

4 Use the fonts as needed, making sure the font files are accessible.

When you’re finished with the fonts, you can close them to free up memory. When
you quit Font Reserve or shut down your computer, the temporary fonts are removed
from the database. If your computer crashes, Font Reserve will restore the temporary
fonts for you.

Using DropSet for Temporary Fonts
If you’re adding fonts temporarily often, you may wish to set up the DropSet applet
exclusively for this purpose. Double-click the DropSet applet and choose Edit ➛
Preferences. Set your Font Files and Expert Options preferences as discussed, then
click OK.

Anytime you receive a job folder or folder of fonts from a client, you can drag-and-
drop the folder onto the DropSet applet. DropSet creates a new set, consisting of those
fonts, which you can rename according to the job. When you print, it’s easy to confirm
that all the necessary fonts are open. And when you’re finished for the day, the fonts
are automatically removed from the database.
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Adding Fonts and Activating them Simultaneously

Whether you’re adding fonts via the vault or alias method, and whether you’re
adding the fonts temporarily or permanently, you can choose to activate the fonts as
they’re added. At the same time, you can choose to deactivate other fonts that are
active temporarily. This helps control how many fonts are active on your computer.
For example:

• A service bureau operator can drag a client’s job folder onto the DropSet applet,
specify that the fonts are added via the alias method, automatically activate the
fonts, and deactivate all currently active fonts. The operator can then begin working
on the job, confident that the appropriate fonts are active.

• A graphic designer might receive a font for an ad that needs to be edited immediately,
add the font to the vault so it’s available for future edits to the job, and activate the
font automatically.

Adding Limited Fonts
To activate fonts as you add them, use one of the drag-and-drop options or the Scan
Folder command as described on page 46. Keep in mind that activating fonts while
you add them is appropriate only while adding a few fonts for a specific job. Adding all
the fonts on your hard drive or all the fonts on a CD-ROM and activating them would
tax your system resources.

Activating Fonts Automatically
When the Preferences dialog box displays, you need to change a setting to specify that
the fonts are activated temporarily. If you have Always open this window unchecked,
confirm your setting in the Preferences dialog box before attempting to add fonts or
press the Command key while you drag the fonts to open the Preferences dialog box.

In the Preferences dialog box, change the following settings to add fonts temporarily:
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1 Choose an option in the Font Files area. Service bureaus may wish to use Leave in
place, while individual users may prefer Move into Vault or Copy into Vault.

2 In the Expert Options area, check Activate added fonts temporarily. Fonts that
are active temporarily remain active until you deactivate them or shut down your
computer.

The Expert Options area of the Preferences dialog box lets you activate fonts as you 
add them.

3 If you want to deactivate all the fonts in your database that are active temporarily,
check Deactivate all temp active fonts in the Expert Options area.

4 Click OK.

Since the fonts are active, you can begin using them. If your computer crashes, Font
Reserve will automatically reactivate the fonts. If you shut down your computer, the
fonts will be deactivated.
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Handling System Fonts

The fonts that you store in the Fonts folder inside your System Folder are not managed
by Font Reserve. (This folder is simply referred to as the System Fonts folder hereafter.)
These fonts load at startup, before Font Reserve, and are therefore available for use in
control panels, system extensions, and startup applications as necessary. You can view
and update your list of system fonts using the Browser.

Font Reserve maintains a set called “System Fonts” to show you the fonts that are cur-
rently in your System Fonts folder. When Font Reserve detects a change to your System
Fonts folder, it prompts you to rescan the folder. Choose Rescan System Fonts from
the File menu to update your System Fonts set and accurately display the contents of
your System Fonts folder.

The System Fonts set, which includes the fonts that reside in your System Fonts folder.

The System Fonts set has the following characteristics:

• It lists all the fonts that reside in your System Fonts folder.

• The fonts that reside in the System Fonts folder are permanently active; they cannot
be activated or deactivated through Font Reserve.

• A padlock icon next to the set, and next to each font in the set, indicates that these
fonts cannot be deleted or deactivated through Font Reserve.

• You can preview and print fonts in the System Fonts set, and you can change the
class, owner, and foundry (see Chapter 8: “Managing Fonts”). You can also drag
fonts to the desktop to create copies of them.

• Although the set does not update automatically, Font Reserve notifies you when it
detects a change to the System Fonts folder. Choose File ➛ Rescan System Fonts to
update the System Fonts set.
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Resolving Problem Fonts

When you add fonts to Font Reserve, the Scanner identifies corrupt fonts, duplicate
fonts, and orphan fonts. All this information is recorded in a log, which you can use to
attempt to resolve the problems. For example, if the log reports that a font is corrupt,
you can reinstall it.

The Font Reserve Activity Log
The Activity Log records everything Font Reserve does, including starting up, shutting
down, examining fonts, and adding fonts. Any time you add a great deal of fonts to
Font Reserve — for example, if you add all the fonts on your hard drive after installa-
tion — you may want to look at the Activity Log to determine if you have any prob-
lem fonts. To view the Activity Log from the Browser or the Font Reserve Settings con-
trol panel, choose File ➛ Log or press Command+L.

The Activity Log records problems encountered while adding fonts.

The Activity Log has the following characteristics:

• The log lists the last 5,000 activities of Font Reserve including reporting corrupt,
duplicate, or orphan fonts.

• The Print button lets you print the log and use a hard copy for troubleshooting.

• The Export button lets you save the log as a text file, which you can send to another
user if necessary while troubleshooting.
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• The Clear button lets you delete the contents of the log. Since the log holds 5,000
activities, you may wish to clear it before adding a great deal of fonts.

• When Show Numbers is checked, Font Reserve assigns a number to each activity,
from 1 to 5,000.

• When Show Dates is checked, Font Reserve displays the date of all activities.

• When Show Debugging Info is checked, the Activity Log displays detailed informa-
tion that is useful for debugging problems that may occur in the application.
Generally, you can ignore this option.

Tip: The Show Numbers, Show Dates, and Show Debugging Info options are provid-
ed to make troubleshooting fonts and Font Reserve more efficient — especially if
you’re working with DiamondSoft’s technical support.

Corrupt Fonts
Corrupt fonts are often the source of crashes and other problems on your computer.
Font Reserve defines a corrupt font as any font for which the font resources cannot be
opened, appear to contain inconsistent information, or have incorrect values in impor-
tant fields of the resource.

Most of the time, if a font is corrupt, it cannot be repaired. However, there are certain
types of minor problems that can be corrected, and there are certain types of problems
that can be safely ignored.

The Font Reserve Scanner identifies corrupt or problem fonts during the Check
phase. Depending on the type of problem encountered, Font Reserve will either fix the
problem and add the font to Font Reserve, ignore the problem and add the font to
Font Reserve, or determine that the font is corrupt beyond repair and not add the font
to Font Reserve. The Activity Log records the type of corruption encountered and the
full path to each problem font file.

• Repairs: If a font’s FOND resource contains an entry for an associated font resource
(a screen bitmap, NFNT resource, or TrueType outline, sfnt resource), and the asso-
ciated resource is missing or corrupt, Font Reserve repairs the corruption by remov-
ing the entry. The following log entries indicate that this type of repair occurred:
Missing Association Resource, Corrupt Association Resource or Invalid Association
Resource. Although the font is added to Font Reserve and is usable, we advise you to
reinstall a clean copy of the font.
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• Ignores problems: TrueType fonts often generate Checksum Errors, which means
they have incorrect checksum values. However, the font resources are usually valid
and healthy, so the fonts are added to Font Reserve.

• Fonts not added: Some font files are corrupt beyond repair or use and cannot be
added to Font Reserve. The fonts remain in their original location, and the Activity
Log reports the font as Corrupt. Delete and replace any corrupt font files immedi-
ately, since they are a primary cause of system crashes.

Duplicate Fonts
If the Activity Log reports a font as a Duplicate, the font is not added to Font Reserve.
See “Handling Duplicate Fonts” on page 58 for information about how Font Reserve
determines fonts are duplicates.

Orphan Bitmaps and Orphan Outlines
On Mac OS, PostScript fonts consist of two different files: the screen bitmap and the
PostScript outline. For fonts to display and print correctly, both the bitmap and out-
line file must be present. If one of the files is missing, the existing file is referred to as
an orphan bitmap or an orphan outline.

Since orphan fonts are virtually unusable, you may want to locate and add the corre-
sponding font files as soon as you add fonts to Font Reserve. To quickly view all your
orphan fonts, use the Browser rather than the Activity Log. Choose Filter ➛ Orphan
Outline or Filter ➛ Orphan Bitmaps.

Choosing Filter ➛ Orphan Outlines yielded the Officiana Sans font family, which is missing its
bitmap files.

If you have access to the missing files, add them to Font Reserve to create a healthy PS
Pair (PostScript) font. If you want to delete the orphans, see “Removing Fonts from
Font Reserve” on page 60.
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You may wish to keep orphan outline fonts for bold or italic instances of a font. In cer-
tain applications, such as QuarkXPress, applying bold or italic type style will access the
bold or italic instance of the font (if it’s available). A simulation of bold or italic will
display on-screen (since the bitmap component of the actual font is missing), but the
actual outline font will print.

Matching Bitmap and Outline Files
Font Reserve uses a variety of criteria to match bitmap and outline files. The most sig-
nificant criteria is that the bitmap’s PostScript name (derived from the style-mapping
table inside its FOND resource) matches the outline’s PostScript name. Font Reserve
only matches a FOND resource of a screen bitmap font to a PostScript outline font.
Font Reserve does not match associated bitmap resources (NFNT or FONT resources)
to outline fonts.

Because of this criteria, occasionally the Browser will show that you have a healthy
PostScript pair for a base font, such as Futura, while other instances of fonts in the
Futura family (Futura-Bold, Futura-Oblique, etc.) are Orphan Outlines. Usually, this
happens when your fonts have been “harmonized” by Suitcase or some other program.
Shareware fonts, or fonts from smaller foundries, may also trigger this problem.

If this happens with your fonts, first remove the fonts from Font Reserve and add
fresh, original copies of the fonts that have not been harmonized. If this is not possi-
ble, or if this results in the same situation, you can solve the problem in another way.
Whenever you activate the base font, such as Futura, make sure you also activate all the
corresponding PS Outline fonts. This ensures that all your styles are available when
you are creating or printing a document. To ensure that you’re selecting all the fonts,
choose View ➛ Group by Family, then activate the entire family.
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Handling Duplicate Fonts

In Font Reserve, a “duplicate font” is a font with the exact same PostScript name, for-
mat, foundry, version number, kerning table, PostScript outline file size, and location
as another font in the database. The Font Reserve Scanner identifies duplicates during
the Add phase, and does not add the fonts. The Activity Log displays the entry
Duplicate along with the path to the font.

Since the criteria for duplicate fonts is so specific, you’ll often see several fonts of the
same name listed in the Browser. Often, it’s a simple matter of having two different
versions of the same font. However, sometimes the difference is more subtle such as
different locations or different kerning tables.

Same Font, Different Locations
Location may be the most significant criteria in determining if fonts are duplicates. If
you add two copies of the exact same font to Font Reserve, but the two font files exist in
different locations, both fonts will be included in the database. If you’re adding fonts via
the alias method, the font files are usually in a unique location and Font Reserve will
not encounter a duplicate. Therefore, Font Reserve actually only prevents you from adding
duplicate fonts to the vault. If you’re using the alias method, and you attempt to add
fonts that you’ve already added from the same location, Font Reserve will identify these
files as duplicates and prevent you from adding them.

To display the location of a font file in the Browser, check Location in the Columns
panel of the Preferences dialog box (Edit menu). The Location column displays a
location for each font, such as System Folder, Vault, or Macintosh HD. For the precise
location of a font, Command+click its location to display a pop-up.

Command+clicking a font’s location displays the full path to the font.
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The location criteria explains why you might see several copies of the exact same font
in your database. For example, your database might include three copies of Arial-
Black: one in your System Fonts folder, one in the vault, and one added via the alias
method (and located on another volume). You might even add two copies of Arial-
Black from the same volume, but in different folders, and the two fonts will be added
separately.

Note About Kerning Tables
Font Reserve computes and maintains information about a font’s kerning table and
PostScript outline file size to ensure that it maintains modified font files. For exam-
ple, if a graphic designer edits a font’s kerning table for a particular job, Font Reserve
considers the modified font to be different from the original font. A graphic designer
might also add characters to a font using a program such as Fontographer. The Post-
Script outline file size increases, notifying Font Reserve that the font is modified.

Determining Differences
If it appears that you have duplicate fonts in the Browser, use the Columns panel of
the Preferences dialog box (Edit menu) to display more information about the fonts.
Once you compare all the information, you’ll probably find the difference.

The Columns panel in the Preferences dialog box controls the information displayed about fonts in
the Browser.
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Removing Fonts from Font Reserve

You can remove corrupt fonts, orphan fonts, unused fonts, and unused sets from Font
Reserve by deleting them from the Browser. If you want to replace a font with a differ-
ent version, you need to delete the existing fonts as well. Deleting fonts has different
consequences depending on whether you’re deleting sets or individual fonts, and how
the fonts were added to Font Reserve.

Consequences of Deleting Fonts
When you delete fonts or sets, they are deleted from the database and they no longer
display in the Browser. However, depending on what you’ve selected, you may or may
not be deleting the physical font files:

• Deleting a font added via the alias method and displayed in italics deletes the font
from the database, but not from your computer.

• Deleting a set deletes the set’s folder and the font references within it. Since sets con-
tain only references to fonts, no fonts are deleted from the database or from your
computer.

• Deleting a font added via the vault method and displayed in roman type deletes the
font from the database, and deletes the physical font files from the vault.

If you clicked Copy into Vault when you initially added the fonts, you may have a
backup copy of deleted fonts on your hard drive. However, if you clicked Move into
Vault, deleting fonts in the vault may delete your only copy of the fonts.

Deleting Fonts
You can use the Delete button in the Browser or the Finder trash can to delete fonts.

1 Open the Browser and select the sets or fonts you want to delete. Shift+click to select
multiple items and marquee to select a range of items.

2 Click the Delete button at the top of the Browser. You can also drag you selection
onto the Finder’s trash can.

60 — Using Font Reserve

Chapter 4: Adding and Removing Fonts



3 Read the alert dialog box, which describes what you’re deleting.

When you delete sets or font references within sets, an alert asks you to confirm the deletion.

When you delete fonts, an alert warns that you may be deleting your only copy of the font files.

4 Click Don’t Delete to cancel or click Delete to delete the selection.

Tip: To bypass the alert, press the Option key while you click the Delete button, or
drag your selection to the Finder trash can.
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Delivering Fonts to a Service Bureau

When you’ve completed a job and are ready to deliver it to a service bureau, you need
to prepare the fonts for delivery. The easiest way to do this is to drag-copy the fonts
from the Browser. Even if the fonts were added to Font Reserve via the alias method —
and are therefore available to copy at the Finder rather than through Font Reserve —
it may be easier to locate the correct fonts using the Browser.

Locating the Correct Fonts
As most graphic design professionals know, it’s imperative that you provide the service
bureau with the exact fonts you used to design the document. Any variation in ver-
sion, foundry, etc. can reflow text and affect your design.

If you created a set for the job, you’ve already isolated the fonts. However, if you relied
on Font Reserve to automatically activate fonts, or you activated fonts for the job on-
the-fly, you may not know exactly which fonts were used. If the source application has
a “collect for output” or “font usage” feature, you can list the fonts. To confirm that
you’ve selected the correct fonts, you can activate only those fonts, then open and print
the document.

To locate the fonts in the Browser, use the alphabet strip, filters, or other viewing and
sorting features in Font Reserve. See Chapter 7: “Viewing and Sorting Fonts.”

In QuarkXPress 4.x, the Fonts panel of the Usage dialog box lists all the fonts used in a document.
The More Information check box displays specific information about each font.
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Dragging Fonts Out of the Browser
If the fonts you need for a job are in a set, simply drag the set from the Sets area to the
Finder. (For example, if you’re delivering the documents on a ZIP disk, drag the set to
the ZIP icon.) Font Reserve will create a folder, with the same name as the set, and
place copies of all the fonts in it.

If the fonts you need for a job are spread throughout the Fonts area, first create a fold-
er at the Finder for the fonts. Then locate each font and drag it to the folder. Font
Reserve will copy each font into the folder.
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Chapter 5: Activating and Deactivating Fonts

Once you add fonts to Font Reserve, you can begin activating and deactivating

them through the Browser. The Browser lets you quickly find the fonts you need,

then activate individual fonts, families, suitcases, or sets. You can activate fonts

permanently so they’re always available or temporarily so they’re available until

you shut down your computer. Once fonts are active, they’re available automati-

cally in many supported page layout and graphics applications.

If you activate fonts permanently, you can deactivate them manually when

you’re finished using them. For example, if you have a month-long project for a

client, you may wish to place the fonts for the job in a set and activate the set

permanently. When the project is finished, you can deactivate the set. You can

easily see whether a font is activated permanently, activated temporarily, or

inactive in the Browser.
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Methods for Activating Fonts

To make the most efficient use of Font Reserve and your system, you need to carefully
consider which fonts you have active. You may have some fonts that you keep active all
the time, some that you activate simply to print a job, and others that are inactive most
of the time.

Font Reserve, by default, activates your original font files, but you have the option to
activate copies of font files. Understanding why you need to control the number of active
fonts and the choices you have for activating fonts helps you make the appropriate
choices for your workflow.

All Fonts All the Time?
You may be tempted to activate all your fonts so they’re always available to you.
Unfortunately, as you probably know, this causes a variety of problems:

• Fonts consume RAM that might otherwise be available to applications.

• Font menus within applications become extremely long and difficult to view and
choose fonts from.

• Applications launch slowly because they need to scan all the active fonts when they
start up.

• The more fonts you have active, the more system resources are active, and the higher
the probability that resources will become corrupt due to misbehaved applications
or system crashes.

In general, you should activate only the fonts you use frequently or that you need for a
particular job. Having fewer fonts active will improve the overall efficiency of your sys-
tem and your applications.

66 — Using Font Reserve

Chapter 5: Activating and Deactivating Fonts



Activating Fonts
Font Reserve activates a font by activating the suitcase in which that font resides.
Therefore, all the fonts that are contained in the same suitcase as the font you are acti-
vating are activated as well. When you deactivate a font, all the fonts contained in the
same suitcase as that font are also deactivated. To see the suitcase a font is in, choose
View ➛ Group by Suitcase in the Browser.

Fonts in the vault reside in suitcases consisting of all other members of the font family
from the same foundry and of the same version. For example, all your Adobe Times
fonts with the same version number are placed in the same font suitcase within the
vault. Therefore, activating Times-Roman also activates Times-Bold, Times-Italic, and
Times-BoldItalic (assuming you have the entire family of Times with the same version
number).

Fonts added via the alias method reside in their original suitcases, along with all the
other fonts that were originally part of that suitcase. For example, if a client gives you a
suitcase called “Buzz Design Fonts” containing all the fonts used for a newsletter, this
suitcase remains intact if you add it to Font Reserve using the alias method. If this
suitcase contains Times-Roman and Bauhaus-Bold, then activating Times-Roman also
activates Bauhaus-Bold. However, the remainder of the Times and Bauhaus families
are not activated since they are not contained in this suitcase.

By default, Font Reserve activates font suitcases “in-place,” meaning wherever they are
located on your system. Fonts that are located in the vault are activated in the vault.
Fonts located on a CD-ROM, ZIP, or remote server, are activated on that volume. If
fonts are located on a remote server, it is possible for many Font Reserve users to acti-
vate the same fonts at the same time without problems. This is important in a work-
group environment, where all the fonts may be stored on a central “font server.” Each
individual user can activate the fonts on the server from their local Font Reserve data-
base, and Font Reserve allows multiple users to activate the same fonts at the same
time without encountering problems.
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Activating Copies of Fonts
Besides the default method of activating fonts, Font Reserve also provides the option
to activate copies of fonts. When this option is selected, Font Reserve makes a copy of
the fonts you select to activate. The screen fonts are placed in temporary suitcases in
the Font Reserve Database folder, and the printer outline fonts (in the case of Post-
Script fonts) are placed in the System Fonts folder. The temporary suitcases are then
activated instead of the original font suitcases. When you deactivate a font, Font
Reserve removes the copy of the font — both the screen font and the printer font —
automatically.

Activating copies of fonts is a slower method of activating fonts because Font Reserve
must first copy the font resources to the temporary suitcases before activating them.
However, there are a number of benefits to activating copies of fonts:

• You activate only the fonts you need (not the font’s entire suitcase), which gives your
precise control over the fonts being activated.

• Your original font files are protected from corruption, since they are never actually
opened on your system.

• If the fonts reside on a network server, they are copied and activated on your local
drive rather than on the server — so the files are not affected by the traffic on the
network or problems with the server.

• If the fonts reside on a CD-ROM, they are copied and activated on your local hard
drive — so you are able to eject the CD-ROM and still continue to work with those
fonts.

If any of these reasons appeal to you, then you should choose to activate copies of
your fonts.

68 — Using Font Reserve

Chapter 5: Activating and Deactivating Fonts



Setting Preferences to Activate Copies of Fonts
By default, Font Reserve activates fonts in place. If you work with fonts over a network
often, or if you’re concerned about font corruption, you may wish to activate fonts in
copy. To activate fonts in copy:

1 Choose Preferences from the Edit menu.

2 Click the Activation icon in the scroll bar at left.

3 Check Activate copies of fonts.

The Activate copies of fonts preference in the Activation panel.

4 Click OK to implement the change.

Limit to the Number of Active Fonts
The Mac OS allows a maximum of 128 suitcase files to be open at one time. Font
Reserve can circumvent this limit using its “in-copy” activation method. When using
the “in-copy” activation method, Font Reserve is able to activate thousands of fonts at
one time — although this is not recommended.

If you use the default “in-place” activation method, Font Reserve automatically switch-
es to activating copies of fonts when it begins to approach the Mac OS limit of 128
active suitcases. This allows you to activate more fonts than the 128 suitcase limit
imposed by the Mac OS.

If you keep 128 suitcases in your System Fonts folder, Font Reserve is unable to acti-
vate any fonts. In this case, if you attempt to activate a font, Font Reserve displays an
error message.
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Activating/Deactivating Fonts

The Browser lets you activate and deactivate fonts as you need them. When a font 
is active, it’s available to all Mac OS applications. In applications that dynamically
update their font menus, active fonts are immediately added to the font list (these
include most of the major graphics applications, such as QuarkXPress, PageMaker,
Framemaker, Illustrator, and Freehand). Applications that don’t dynamically update
their font menus, for example Microsoft Word or Claris Works, need to be relaunched
in order to access these fonts.

Font Reserve provides a wide range of options for selecting fonts in the Browser and
activating or deactivating those fonts. Depending on your needs and workflow, you
can activate a font family while designing a new document, activate a set for a project,
activate a single font used in a document you’re editing, or have Font Reserve activate
fonts automatically when you open documents.

Activating Fonts Permanently or Temporarily
When you activate fonts permanently, they stay active until you close them. If you shut
down your computer, the fonts are activated again at startup. When you activate fonts
temporarily, they stay active until you shut down your computer. In general, you’ll
activate permanently the fonts you use daily and activate temporarily the fonts you use
for quick jobs. (If your computer crashes, Font Reserve reactivates fonts that you have
activated temporarily.)

Note: When you add fonts to Font Reserve, you can check Deactivate other temp
active in the Activation panel of the Preferences dialog box (Edit menu). If you check
this, Font Reserve deactivates all your fonts that are active temporarily.

Selecting Fonts to Activate or Deactivate
You can select individual fonts, multiple fonts, families, suitcases, and sets to activate
or deactivate:

• Click to select an item.

• Shift+click or marquee to select a range of continuous items.

You can select a combination of items at the same time, such as a family and an indi-
vidual font, but you cannot select items in the Fonts and Sets areas at the same time.
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The Tiger family, Times-Bold, and Times-Italic are selected in the Fonts area.

• To select individual or multiple fonts in the Fonts area, list fonts individually by
opening the family or suitcase (or choosing View ➛ Ungroup).

• To select individual or multiple fonts in the Sets area, open the set.

• To select a family, choose View ➛ Group by Family.

• To select a suitcase, choose View ➛ Group by Suitcase.

Activating Selected Fonts
Once fonts are selected, you have a variety of options for activating them. Remember, if
you are activating fonts in place, activating an individual font activates all the fonts in
its suitcase.

• Click the Perm button or the Temp button at the top of the Browser to activate the
selection permanently or temporarily.

• Click the toggle button to the left of one of the selected items, or press
Return/Enter on the keyboard. Depending on your Toggling an inactive font prefer-
ence, the fonts are activated permanently or temporarily.

• Choose an option from the Edit menu: Activate Temporarily or Activate
Permanently.

• Press Command++ (plus sign) to activate fonts temporarily or
Command+Option++ (plus sign) to activate fonts permanently.

• Display a pop-up menu by Command+clicking the toggle button to the left of
one of the selected items. Choose Activate Temporarily or Activate Permanently
from the pop-up menu.
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Setting Toggle Preferences
When you toggle fonts active or inactive — using the toggle button or the Return/
Enter key — a preference controls whether the fonts activated temporarily or perma-
nently. To change this preference:

1 Choose Preferences from the Edit menu.

2 Click the Activation icon in the scroll bar at left.

3 Choose an option from the Toggling an inactive font activates it area: Temporarily
or Permanently.

The Activation panel.

4 Click OK to implement the change.

Deactivating Selected Fonts
If you are activating fonts in place, deactivating an individual font deactivates all the
fonts in its suitcase. If you are activating fonts in copy, the copy is deactivated and then
removed from the temporary suitcase. Deactivating a font reference in a set deactivates
the font only if no other active sets require the font. Deactivating a font (in the Fonts
area), deactivates all its font references in any active sets.

Due to potential application or system crashes, it’s best to deactivate fonts when no
other applications are running. Once fonts or font references are selected, you have a
variety of options for deactivating them:

• Click the Deact button at the top of the Browser.

• Click the toggle button to the left of one of the selected items.

• Press Return/Enter on the keyboard, or press Command+- (minus or hyphen).

• Choose Deactivate from the Edit menu.

• Display a pop-up menu by Command+clicking the toggle button to the left of
one of the selected items. Choose Inactive from the pop-up menu.
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Activating Document Fonts Automatically

When you open documents in some applications, Font Reserve attempts to activate
the appropriate fonts. For example, if you open a document in Freehand that requires
Bauhaus Bold, then Font Reserve locates and activates Bauhaus Bold. The Auto-
Activation feature requires the Font Reserve system extension and is on by default.
If you have more than one version of a necessary font in your catalog, Font Reserve
decides which font to activate.

Auto-activated fonts are activated temporarily rather than permanently, so they deacti-
vate when you shut down your computer. While the fonts are active, they are placed in
a temporary set called “Auto-Activated Fonts.” Font Reserve automatically activates
fonts in most applications — except PageMaker and Illustrator.

Disabling Auto Activate
If you prefer to activate fonts manually, you can turn off Auto Activate in the Font
Reserve Settings control panel:

1 Select Font Reserve Settings from the Control Panels submenu of the Apple menu.

2 Uncheck Activate fonts automatically in the Auto-Activation area. (If the Font
Reserve system extension is not running, this feature is gray and unavailable.)

The Activate fonts automatically check box in the Font Reserve Settings control panel.

3 Click the close box to implement your changes.

Using the Font Reserve XTension for QuarkXPress
Font Reserve provides an XTension for QuarkXPress 3.3x and 4.x that activates fonts
automatically and allows you to replace missing fonts and handle font name conflicts.
Whether or not you use the Auto-Activation feature, the XTension activates the appro-
priate fonts for each document you open. See the “Font Reserve XTension User
Manual” included with Font Reserve for more information.
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Determining a Font’s Status

To determine the status of a font, family, suitcase, or set, check the state of the tri-state
button to the left of it:

• A black circle means all the fonts are active permanently.

• A gray circle means all the fonts are active temporarily.

• A white circle means all the fonts are inactive.

• If the fonts in a family, suitcase, or set are in different states, multiple icons display.

In the Letterhead set, GillSans, GillSans-Bold, and GillSans-BoldItalic are active permanently,
while GillSans-Italic (which is in a different suitcase) is active temporarily. The fonts in the Mrs
Eaves family are all inactive.

Font references in a set reflect the status of the set — not the status of the font:

• If a set is inactive, its font references are shown as inactive. For example, say GillSans
is active permanently in the Fonts area, while a set containing a GillSans font refer-
ence is inactive. The GillSans font reference in the set is shown as inactive until you
activate the set.

• If the same font reference is in multiple sets, the font references do not reflect each
other’s states. For example, if there’s a font reference for GillSans in an inactive set,
that font reference is shown as inactive. If there’s another font reference for GillSans
in an active set, that font reference is shown as active.

If you want to be sure of the status of a font, look at the font in the Fonts area of the
Browser. This displays the actual status of the font.
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Handling Activation Conflicts

If you have a large variety of fonts from different clients, you may encounter conflicts
while activating fonts. For example, you may attempt to activate two different versions
of a font with the same menu name. Or, you may attempt to activate two fonts with the
same font ID. Font Reserve can handle both of these conflicts for you automatically.

Resolving Font ID Conflicts
When you activate a font that has the same Font ID as a currently active font, Font
Reserve assigns a temporary Font ID to the font. The font reverts to its original Font
ID when it’s deactivated.

In handling font ID conflicts, Font Reserve always activates the second font using the
“in-copy” activation method, even if the default “in-place” activation method is select-
ed. See “Methods for Activating Fonts” on page 66.

Resolving Menu Name Conflicts
Having two fonts with the same name active at the same time is never a good idea —
it may lead to incorrect results and cause confusion within applications. By default,
Font Reserve will not activate two fonts with the same menu name. If you do attempt
to activate two fonts with the same name, Font Reserve provides different methods for
handling the situation. To specify how font name conflicts are handled:

1 Choose Preferences from the Edit menu.

2 Click the Activation icon in the scroll bar at left.

The conflict controls in the Activation panel.
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3 To specify what Font Reserve does if you select two or more fonts with the same
name to be activated, choose an option from the When the names of fonts within a
selection conflict with each other pop-up menu:

• Choose the best one activates the “best” choice according to these criteria. Font
Reserve chooses a PS Pair. If more than one of the fonts is a PS Pair, Font Reserve
chooses an Adobe PS Pair. If more than one of the fonts is an Adobe PS Pair, Font
Reserve chooses the font with the most recent version number. Therefore, Choose
the best one determines best according to this hierarchy: PS Pair, Adobe, latest
version.

• Rename to avoid conflict activates both fonts, appending a number to the name
of the second font (for example, the second instance of Garamond you activate
will be Garamond2). The font reverts to its correct font name when deactivated.
In renaming the second font, Font Reserve always activates this font using the
“in-copy” activation method, even if the default “in-place” activation method is
selected.

4 To specify what Font Reserve does if you select a font with the same name as one
that is already active, choose an option from the When the name of a selected font
conflicts with that of an active font pop-up menu:

• Leave the active font does not activate the selected font, leaving the currently
active font with the same name active.

• Switch to the selected font activates the selected font, deactivating the other font
with the same name.

• Rename the selected font appends a number to the name of the selected font
(for example, the second instance of Times you activate will be Times2). The
font reverts to its correct font name when deactivated. In renaming the second
font, Font Reserve always activates this font using the “in-copy” activation
method, even if the default “in-place” activation method is selected.

5 If you want Font Reserve to notify you when it detects font name conflicts, check
Display name conflict warnings. The warnings list the conflicting fonts and
describe the actions taken according to your Activation preferences. If you don’t
want Font Reserve to notify you when it detects font name conflicts, uncheck
Display name conflict warnings.
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Chapter 6: Viewing and Sorting Fonts

Font Reserve provides various methods for you to display fonts in the Browser. For

example, you can sort fonts alphabetically by name, by family, or by foundry. You

can choose to list fonts individually or list them by family or suitcase. In addition,

you can limit the number of fonts displayed to those that start with specific letters

of the alphabet.

To locate and display fonts with specific characteristics, you can “filter” fonts.

Font Reserve provides several default filters — such as Active Fonts, PostScript

Only, and TrueType Only — and allows you to create and edit additional fil-

ters. Custom filters can combine complex criteria such as version, PostScript

name, and FOND ID.
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Viewing Font Information in the Browser

The Browser displays columns of information, such as family and foundry, for each
font. You can change the columns that display based on your needs, and you can sort
the fonts in the Browser according to each column.

Setting Preferences for Browser Columns
The Columns panel of the Preferences dialog box lets you control which columns of
information display in the Browser. To customize the columns:

1 Choose Preferences from the Edit menu.

2 Click the Columns icon in the scroll bar at left.

3 Check the information you want to display in the Show Attributes area. For specific
information about any of the columns, see “Understanding Font Information” on
page 80.

The Columns panel of the Preferences dialog box.
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4 Choose an option from the In “Name” column display each font’s pop-up menu to
control the name displayed for fonts in the Browser:

• PostScript Name: The font names used in PostScript documents and sent to Post-
Script output devices; PostScript names are commonly used in the design and
graphic arts publishing community. The menu name displays for older bitmap
fonts that do not have PostScript names.

• Menu Name: The font names displayed in font menus of Mac OS applications
(when you’re not using a utility such as TypeTamer or Adobe Type Reunion).
Since PostScript outline fonts do not have menu names, their PostScript name
will display.

5 Check Show “Font” menu in menubar to display a Font menu in the Browser that
lists all your active fonts.

6 Click OK to change the information displayed in the Browser.

Sorting Fonts
Fonts and sets in the Browser sort according to the underlined column. To change the
sorting order, click a column heading in the Sets or Fonts area. Clicking a title sorts
only the fonts currently displayed in the Browser — which is limited by the alphabet
strip and the current filter.

Fonts and sets are sorted by Name in this example.
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You have the following sorting options:

• Click the Active column’s title to sort fonts in the following order: all temporarily
active fonts, all permanently active fonts, then all inactive fonts. Fonts are listed
alphabetically within each category.

• Click the Name column’s title to sort fonts alphabetically by PostScript name or
menu name (according to your preference setting in the Columns panel).

• Click one of the other column’s titles to sort fonts as described in the next section,
“Understanding Font Information.” Depending on your settings in the Columns
panel, the Browser displays the following columns: Class, Created, Family, FOND,
Foundry, Kern Checksum, Kind, Location, Outline Size, Owner, and Version.

Note: When you select one of the other columns, the PostScript name or menu
name is used as the second-order sort criteria. This means that if you are sorting by
Foundry, all the Adobe fonts are listed together and sorted alphabetically by name,
followed by all Agfa fonts sorted alphabetically by name, and so on.

Understanding Font Information
The columns of information that you can choose to display in the Browser and sort
fonts by work according to the descriptions below.

• Class: This represents the style of the font, for example serif, modern, or script.
Sorting fonts by Class lists fonts according to class in the following order: default
classes in the Class menu order, followed by custom classes in the order in which
you created them.

• Created: This represents the date and time the font was first added to Font Reserve
(not the date the physical font file was created). Sorting fonts by Created lists fonts
in descending order beginning with the most recently added font.

• Family: This represents the font’s family name, derived from the family specified by
the designer/foundry within the font resources. Sorting fonts by Family lists fonts
alphabetically by family: Garamond, Helvetica, Minion, for example.

• FOND: This represents the FOND ID number, which is included in all healthy fonts
(except PostScript outline fonts). The Fond ID is used by the Mac OS to identify each
active font. Although Font Reserve resolves any FOND ID conflicts in active fonts, it
never changes a font’s Fond ID permanently. Sorting fonts by FOND lists fonts in
numeric order, starting with 0 (used for PostScript outline fonts). If there are multi-
ple fonts sharing the same FOND ID, they are sorted alphabetically by name.
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• Foundry: This represents the company from whom you licensed the font. Sorting
fonts by Foundry lists fonts according to foundry in the following order: default
foundries in the Foundry menu order, followed by custom foundries in the order in
which you created them.

• Kern Checksum: This is a unique number that represents the information in the
kerning table of the font. Sorting by Kern Checksum lists fonts numerically accord-
ing to this number, but the sorting order has little meaning. Sorting by Kern
Checksum is primarily useful for determining the subtle difference between two
seemingly identical fonts.

• Kind: This represents the format of the font listed, for example, PS Pair, Bitmap, or
TrueType. Sorting fonts by Kind lists fonts in the following order: Bitmap, PS Pair,
TrueType, PS Outline, PS MM, PS Outline(3), PS Pair(3), PS Outline(MM),
TrueType GX, TypeOne GX.

• Location: This represents the location of each font: the vault, the volume on which
fonts added via the alias method reside, or the System Folder. Sorting fonts by
Location lists fonts in the following order: System Font, vault, then the various vol-
umes, ZIP cartridges, CDs, etc. on which fonts are stored.

• Note: To find the precise location of a font file added via the alias method,
Command+click the font’s location shown in the Browser. In the case of a PS Pair
font, this will display the location of both the PostScript outline component and the
screen bitmap component of the font.

The Location of a font added via the alias method.
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• Outline Filesize: This represents the file size of the PostScript printer component of
any PostScript font. Sorting fonts by Outline Filesize lists fonts according to this
value, but the sorting order has little meaning. Sorting by Outline Filesize is primari-
ly useful for determining the subtle difference between two seemingly identical fonts.

• Owner: This represents the primary owner of a font, which is assigned when the
font is added and may be changed via the Add Ownership command in the Owner
menu. Sorting fonts by Owner lists fonts according to the order in which owners
were added to Font Reserve and are listed in the Owner menu.

• Version: This represents the version number of the font, derived from the font
resources. PS Pairs derive their version number from the outline component of the
font since bitmap fonts do not usually include a version number. Sorting fonts by
Version lists fonts numerically, starting with the lowest number.

Note: Generally, a foundry will change the version number of a font whenever the
font is re-released because some component has changed (the width tables, the char-
acter shapes, etc.). There is no standard for version numbering — many foundries
have their own unique version numbering scheme. Therefore, sorting by Version is
primarily useful for determining the subtle difference between two seemingly identi-
cal fonts. Knowing the version number of a font is important for ensuring that the
identical font is used for the design and output of a document.

Fonts sorted according to the Version column.
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Displaying Fonts According to the First Letter

To limit the number of fonts that display in the Browser and improve the overall per-
formance of Font Reserve, you can display only fonts that start with specific letters.
For example, you can display only the fonts that start with K or only the fonts that
start with K, M, and T. Font Reserve provides an alphabet strip above the Fonts area
for specifying the first letter of the fonts you want to display.

If you have a large font library — more than 3,000 fonts — using the alphabet strip
consistently will greatly improve performance. If you are displaying fonts according to
a specific filter, such as the Active Fonts filter, only fonts that fit the criteria of the filter
and start with the specified letters will display.

To use the alphabet strip:

1 Check the box to the left of the alphabet strip, which is between the Sets and Fonts
areas of the Browser.

The alphabet strip above the Fonts area in the Browser.

2 Select the first letters of the fonts you want to display. Click to select a letter,
Command+click to select multiple letters, and Shift+click to select a range of
continuous letters.

3 The Browser displays only the fonts that begin with the selected letters (within the
current filter).

To display all your fonts again (within the current filter), uncheck the box next to the
alphabet strip. Font Reserve remembers the letters you had checked for the next time
you use the alphabet strip.
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Grouping Fonts by Family

In a design environment, where you’re working with many fonts and often looking for
a particular style, you may wish to group your fonts by family. This will condense your
font list significantly, making it easier to look through and locate fonts. When fonts are
grouped by family, you can activate all the fonts in the family at once, add the family
to a set, and copy the family out of Font Reserve for delivery to a service bureau.

Working with Families
To group fonts by family, choose Group by Family from the View menu. This com-
bines all the fonts in the Fonts area into their respective families. To view fonts within
the family, click the triangle next to the family icon . To display fonts individually
again, choose Ungroup from the View menu.

The Minion family includes 21 fonts, ungrouped and listed individually here.

When grouped by family, one icon displays for the 21 Minion fonts.

To see individual fonts within a family, click the triangle next to the family icon.
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Criteria for Grouping by Family
Fonts must have the following in common to be grouped into a family:

• The same family name.

• The same foundry. Therefore, a Bauhaus font from Bitstream will be placed in a
different family than a Bauhaus font from Monotype.

• The same kind. Therefore, a PS Pair Helvetica font will be placed in a different
family from a TrueType Helvetica font. (If the name and foundry of PS Pair and
PS Outline fonts match, they will be placed in the same family as well.)

These criteria often produce multiple families with the same name — such as a
TrueType Times from Apple and PostScript Times from Adobe. To tell the difference
between families, check the Kind and Foundry columns.

Notes about Grouping by Family
When you group fonts by family, keep the following in mind:

• Grouping fonts by family can be memory intensive. Use the alphabet strip to limit
the number of fonts displayed.

• If you have two different versions of a font with the same name, they will be placed
in the same family. For example, you might have two different versions of
Garamond-Book in the Garamond family.

• If a family contains two versions of a font with the same name, and you activate
the entire family, the fonts are activated according to an Activation preference.
Check your setting in the When the names of fonts within a selection conflict
with each other pop-up menu in the Activation panel of the Preferences dialog
box (Edit menu).

• If you are displaying fonts according to a specific filter, such as the Active Fonts
filter, only fonts that fit the criteria of the filter are displayed within each family.
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Grouping Fonts by Suitcase

If you’re accustomed to working with suitcases and prefer to display fonts that way,
you can group fonts according to their suitcases. If the fonts are in the vault, the suit-
case shown in the Browser represents the suitcases in the database that the fonts are
stored in. (Fonts in the vault are organized into suitcases according to type, foundry,
family, and version.) If fonts were added via the alias method, the suitcases shown in
the Browser reflect the actual suitcases the fonts reside in. If you add a font via the
alias method that is not in a suitcase, the font will be displayed in a suitcase that
reflects the font’s menu name.

Working with Suitcases
To group fonts by suitcase, choose Group by Suitcase from the View menu. This
combines all the fonts in the Fonts panel into their respective suitcases. To view
fonts within the suitcase, click the triangle next to the suitcase icon . To display
fonts individually again, choose Ungroup from the View menu.

The Minion family includes 21 fonts, ungrouped and listed individually here.

When grouped by suitcase, two icons display for the 21 Minion fonts.
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To see individual fonts in a family, click the triangle next to the family icon. The first Minion
suitcase contains display type versions of the fonts, while the second Minion suitcase contains body
text versions.

How Suitcases Affect Activating Fonts
The suitcase structure of fonts is important to know in determining which fonts will
be affected when you activate a font. If you activate a selected font according to the
default method, Font Reserve also activates all the fonts in that font’s suitcase. (If
you’re using the Activate copies of fonts option in the Activation panel of the
Preferences dialog box, only the selected font is activated.) 

To determine which fonts are in a font’s suitcase — and will therefore be activated
along with it — choose Group by Suitcase from the View menu. Click the triangle 
next to the suitcase icon to see which fonts will be activated.
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Finding a Font by Name

You can find a font quickly by typing its name — provided the font is listed in the
Fonts area of the Browser. If the current filter or alphabet strip setting prevents a font
from being listed, you will not be able to find the font. In addition, fonts must be listed
individually rather than by family or suitcase.

To find a font:

1 If fonts are grouped by suitcase or family, choose Ungroup from the View menu.

2 If a filter is in effect, choose None from the Filter menu.

3 Uncheck the alphabet strip or check the letter the font starts with.

4 Click in the Fonts area of the Browser to highlight it.

5 Type the first few characters of the font name to display the Jump to… dialog box.
Enter as many characters as necessary to distinguish the font from others; the field is
not case-sensitive.

The Jump to... dialog box lets you quickly locate a font.

6 Click Jump or press Return/Enter. Font Reserve selects the first font that matches
the name you enter.

Checking “F” on the alphabet strip and typing “friz,” found FrizQuadrata in this example.
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Working with Filters

A filter is a set of criteria that define the fonts you want to display. For example, you
might display all active fonts, all TrueType fonts, or the version of Minion owned by a
specific client. Font Reserve provides a set of useful default filters, an option for creat-
ing a filter on the fly, a filter for displaying fonts in your System Folder, and a method
for saving frequently-used criteria as custom filters. You can import and export cus-
tomized lists of filters to share them among users.

Filters work in conjunction with other display options, such as the alphabet strip and
the grouping options. For example, if you group fonts by family and click M on the
alphabet strip, then use the Active Fonts filter, you will see family groupings for the
active fonts that start with M. Occasionally, the combination gets a little confusing —
for example, if you decide to display all fonts that start with U — and Univers is not
showing up — it may be because the TrueType Only filter is in use.

Using Default Filters
Font Reserve provides a set of useful default filters that let you quickly display a group
of fonts. The default filters, which cannot be edited or deleted, are listed in the lower
portion of the Filter menu.

To use one of the default filters, choose it from the Filter menu. To switch to a differ-
ent filter, choose it from the Filter menu. To turn off the filters, choose None from the
Filter menu.

The Filter menu.
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• Active Fonts displays all the fonts that are temporarily or permanently active. Use
this filter to determine which fonts are available for use in applications.

• Duplicate FOND IDs displays all the fonts in Font Reserve with the same Fond ID.
Use this filter for information about duplicate FOND IDs, which were historically a
problem on Mac OS. Since Font Reserve automatically handles Fond ID conflicts,
there is no reason to worry about these fonts.

• Duplicate PS Font Names displays all the fonts in Font Reserve that have the same
PostScript Name. Use this filter to clean up your font library; see “Resolving
Problem Fonts” on page 54.

• In Vault displays all the fonts that reside in the Vault. Use the filter to determine
which fonts are always available. (Opposed to fonts added via the alias method,
which are available only when their volume is mounted.)

• Last Added Fonts displays the fonts most recently added to Font Reserve. Use this
filter, for example, if you add a collection of fonts and want to confirm the class,
foundry, and owner of new fonts.

• Orphan Bitmaps displays all the screen bitmap fonts that do not have a correspon-
ding printer outline font. Use this filter to troubleshoot problem fonts or clean up
your font library; see “Resolving Problem Fonts” on page 54.

• Orphan Outlines displays all the printer outline fonts that do not have a correspon-
ding screen bitmap font. Use this filter to troubleshoot problem fonts or clean up
your font library; see “Resolving Problem Fonts” on page 54.

• Owned by Default displays all the fonts owned by the default owner (usually,
you). Use this filter to locate a specific owner’s fonts, then, for example, activate 
or delete the fonts. See “Working with Owners” on page 127 for more information
about owners.

• PostScript Only displays all PostScript fonts for which you have both the screen
bitmap and the printer outline component. Use this filter to quickly view your
PostScript fonts.

• TrueType Only displays only your TrueType fonts. Use this filter to quickly view
your TrueType fonts.
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Understanding Filter Criteria
Font Reserve allows you to create a quick filter on-the-fly or a custom filter that is added
to your Filter menu. When you create a quick filter or a custom filter, you specify the cri-
teria (such as foundry), a qualifier for each criteria (such as “is”), and a value for each
criteria (such as “Adobe” for a foundry). Your filter can include an unlimited number of
criteria. For example, the following filter will find the PostScript Garamond fonts whose
primary owner is 5280 Magazine:

The Quick Filter Editor dialog box lets you specify a combination of criteria to locate fonts.

The filter criteria, qualifiers, and values are the same in both the Quick Filter Editor
and the Filter Editor dialog box. The controls work as follows:

• The first pop-up menu is the criteria. Depending on the option you choose, a quali-
fier pop-up menu and value control will display.

• To add criteria to a search, click More Choices. Select a boolean operator, either
“and” or “or” to specify how the criteria work together. (Note: You cannot mix “and”
and “or” in the same filter.)

• To remove the previous row of criteria, click Fewer Choices.

• When you’re finished specifying criteria, click Done. Fonts that meet the filter crite-
ria will display in the Browser.

• If the alphabet strip and the Show System Fonts filter are in use, they will affect the
results of the filter.
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The options in the criteria pop-up menu work as follows:

• PostScript name: Choose a qualifier (is, is not, starts with, ends with, contains),
then enter the PostScript name of the font you’re searching for. For example, “show
fonts whose PostScript name is Minion-Regular” will display all fonts whose
PostScript name exactly matches the name “Minion-Regular.”

• Menu name: Choose a qualifier (is, is not, starts with, ends with, contains), then
enter the menu name of the font you’re searching for. For example, “show fonts
whose menu name contains Bold” will display all fonts whose menu name contains
the word Bold somewhere in the name.

• Kind: Choose a qualifier (is, is not), then choose an option from the value 
pop-up menu: Unknown, PS Pair, PS Pair (3), PS MM, TrueType, TrueType GX,
TypeOne GX, Bitmap, PS Outline, PS Outline (3), PS Outline (MM). For example,
“show fonts whose Kind is not PS Pair” will display all fonts except PS Pair (healthy
PostScript) fonts.

• Active attribute: Choose a qualifier (is, is not), then choose an option from the pop-
up menu: inactive, active temporarily, active permanently. For example, “show fonts
whose active attribute is not inactive” will display all active fonts, whether the fonts
are active temporarily or active permanently.

The value pop-up menu for the active attribute criteria.

• Class: Choose a qualifier (is, is not), then choose a class from the pop-up menu. For
example, “show all fonts whose class is Script” will display all your Script fonts.

• Foundry: Choose a qualifier (is, is not), then choose a foundry from the pop-up
menu. For example, “show fonts whose foundry is Emigre Graphics” will display all
fonts from Emigre.
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• Owners include: Choose an owner from the pop-up menu (there are no qualifiers
for owners include). For example, “show all fonts whose owners include 5280
Magazine” will display all fonts who have 5280 Magazine as an owner of that font,
but are not necessarily the primary owner of that font.

• Primary owner: Choose a qualifier (is, is not), then choose an owner from the pop-
up menu. For example, “show all fonts whose primary owner is 5280 Magazine” will
display all fonts who have 5280 Magazine as their primary owner.

• Version: Choose a qualifier (is, is not, starts with, ends with, contains), then enter
the version information in the field. For example, “show fonts whose PostScript
name is OfficinaSans-Bold and version is 001.000” will display the specified version
of the font.

• Location: Choose a qualifier (is, is not), then choose a location from the pop-up
menu: Font Reserve vault, volume, System Fonts folder. If you choose volume,
choose another qualifier (is, is not, starts with, ends with, contains), then enter the
volume information in the field. For example, “show all fonts whose location is vol-
ume is Font Zip 3” will display all fonts in Font Reserve, added using the alias
method, which reside on the removable Zip cartridge titled “Font Zip 3.”

The volume value has an additional qualifier and value field.

• Family name: Choose a qualifier (is, is not, starts with, ends with, contains), then
enter the family name you’re searching for. For example, “show fonts whose family
name starts with helv” will display all fonts whose family name starts with the word
“helv,” including all fonts belonging to the Helvetica and Helvetica Neue families.

• FOND ID: Choose a qualifier (is, is less than, is greater than, is not), then enter a
numeric value for the Fond ID you’re searching for. For example, “show all fonts
whose Fond ID is 5945” will display all your fonts with a Fond ID equal to 5945.
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• Add time is last scan: Choose this option to display the last fonts added to Font
Reserve. Although there are no qualifiers, you can combine this criteria with other
criteria. For example, “show all fonts whose primary owner is Client A and Add time
is last scan” will display the fonts you recently added for Client A.

• Script: Choose a qualifier (is, is not), then choose an option from the pop-up menu:
Roman, Japanese, Korean, Simplified Chinese, Traditional Chinese, Arabic, Hebrew,
Cyrillic, or Thai. For example, “show all fonts whose language is Simplified Chinese”
will display all your simplified Chinese fonts.

Creating a Quick Filter
To find a group of fonts quickly, you can create a “quick filter” on the fly. Once you
create a quick filter, the fonts that meet the filter criteria will display automatically. To
create a quick filter:

1 Open the Quick Filter Editor dialog box by choosing Edit Quick Filter from the
Filter menu, clicking the Filter button on the Browser, or pressing Command+F.

2 Use the controls in the Show fonts whose area to specify the fonts you want to dis-
play. For additional options, click the More Choices button as many times as you
wish. See “Understanding Filter Criteria” on page 91.

The Quick Filter Editor dialog box.

3 Click Done to display the fonts according to the quick filter.

The criteria you specify is saved for the next time you open the Quick Filter Editor
dialog box.
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Creating Custom Filters
If you consistently search for the same combination of criteria, you can create a cus-
tom filter that is added to the Filter menu. To create a custom filter:

1 Choose Edit Filters from the Filter menu.

2 Click the New button in the Filters dialog box, or press Command+Option+N.

3 Type a name for the filter in the Name field.

The Filter Editor dialog box.

4 Use the controls in the Show fonts whose area to specify the fonts you want to dis-
play. For additional options, click the More Choices button as many times as you
wish. See “Understanding Filter Criteria” on page 91.

5 Click Done to create the new filter.

6 Click OK to return to the Browser; your custom filter displays in the Filter menu.

Editing Custom Filters
You cannot edit the default filters, but you can change the name and criteria specified
in custom filters. To edit a custom filter:

1 Choose Edit Filters from the Filter menu.

2 Select the filter you want to edit. Type the first letters of the filter name to jump to it
quickly.

3 Click the Edit button or double-click the filter name.

4 Change the filter name and/or criteria.

5 Click OK to change the custom filter definition.

6 Click OK to return to the Browser.
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Deleting Filters
You cannot delete the default filters, but you can delete custom filters. To delete a cus-
tom filter:

1 Choose Edit Filters from the Filter menu.

2 Select the custom filter you want to delete. Click to select a filter, Command+click to
select multiple filters, and Shift+click to select a range of continuous filters.

3 Click the Delete button.

4 Click OK to return to the Browser.

Checking Filters
If a filter that you create references criteria that have been deleted — such as an owner,
class, or foundry — the filter will be invalid. You can check the validity of filters you
create to ensure that all your filters work. To check a filter:

1 Choose Edit Filters from the Filter menu.

2 Select the custom filter you want to check. Click to select a filter, Command+click to
select multiple filters, and Shift+click to select a range of continuous filters.

3 Click the Check button. The Filter Check Messages dialog box displays a report
about the validity of each selected filter.

4 If any of the selected filters have invalid criteria, use the Print or Export button to
output the report.

5 Click OK to return to the Filters dialog box.

6 Edit any invalid filters according to the report.

7 Click OK to return to the Browser.

Exporting Custom Filters
To share your custom filters with other Font Reserve users, you can export all or
selected filters as a file. To export custom filters:

1 Choose Edit Filters from the Filter menu.

2 Select the custom filters you want to export. Click to select a filter, Command+click to
select multiple filters, and Shift+click to select a range of continuous filters.
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3 Click the Export button. Use the standard directory dialog box to create a new fold-
er or navigate to a location for the exported filters.

4 Type a name for the exported filters in the Filter File field.

The Filter File field.

5 Click Save to create a file of exported filters.

6 Click OK to return to the Browser.

The filter file is in the location you specified and looks like this . You can email it to
other users or make it available on a network.

Importing Custom Filters
To use custom filters from another Font Reserve user, you can import their file of cus-
tom filters. First, copy the filter file to your hard drive or make sure you can access it
over a network. To import custom filters:

1 Choose Edit Filters from the Filter menu.

2 Click the Import button.

3 Use the standard directory dialog box to navigate to the filter file, which will look
like this .

4 Select the filter file and click Open.

Note: If one of your custom filters has the same name as one of the imported custom
filters, an alert displays. Click OK to override your filters with the imported filters.

5 Click OK to return to the Browser.

If you import a filter with criteria that is not available in your copy of Font Reserve —
such as owners or classes you create — the filter will be imported, but it will be
invalid. You may wish to check the validity of filters after you import them.
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Displaying System Fonts

Since Font Reserve doesn’t manage fonts in the System Fonts folder, by default they are
not displayed in the Browser. However, since you can preview system fonts, copy them
to the Finder, or add them to sets, you may wish to display them in the Browser at
least some of the time. To display system fonts along with other fonts, choose Show
System Fonts from the Filter menu. To hide system fonts, choose Show System Fonts
from the Filter menu again to uncheck it.

Show System Fonts can be used in conjunction with default filters, quick filters, and
custom filters. For example, choosing the Active Fonts filter and the Show System
Fonts filter displays all the fonts in your System Fonts folder and all your fonts activat-
ed through Font Reserve.

When the Show System Fonts filter is active, system fonts display along with other fonts.

If you want to display only fonts in your System Folder, create a quick filter like this:

A quick filter that will display only fonts in the System Fonts folder.
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Chapter 7: Previewing, Printing, and
Reporting

Finding the correct font requires more than looking at names, foundries, and

classes. Sometimes there’s nothing better than looking at the font. Rather than

activating fonts, then applying them to text within an application, you can simply

preview fonts in the Browser. Font Reserve provides a Quick Preview feature for

popping up a sample of fonts, and a Full Preview feature for displaying font with

different text at varying sizes.

The preview features include a Character Map, which helps you locate keyboard

commands for special characters. If you prefer to browse through fonts in print —

or you want to show a variety of typefaces to a client — you can print samples of

selected fonts as a custom type book.
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Using Quick Preview

While you’re designing a document, you may need to identify a font by look rather
than by name. For example, you may have a particular font in mind to activate, but
you’re not sure about its name. To quickly find out what a font looks like, you can
display a pop-up in the Browser called a Quick Preview.

Displaying a Quick Preview
To display a Quick Preview, Command+click a font icon or font reference icon. By
default, the pop-up displays the PostScript name of the font at 72 points.

Command+click a font icon or font reference icon to display a Quick Preview.

Note: If you preview a font added via the alias method, and the original font file is not
available, you cannot preview the font. You cannot preview a PostScript outline font if
its corresponding bitmap font is not available.

Customizing the Quick Preview
You can customize the Quick Preview by changing the point size and text displayed in
the pop-up. To customize the Quick Preview:

1 Choose Preferences from the Edit menu.

2 Click the Previews icon in the scroll bar at left.
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3 To change the point size, specify a new value in the Popup Sample Size field. You
can enter a value up to 256 points or choose an option from the pop-up menu.

The Popup Sample Size controls in the Previews panel.

4 To specify the text used for the Quick Preview, click PostScript Name or Custom
Text. If you click Use Custom Text, type up to 80 characters in the sample area.

5 Click OK to implement the new preferences.

A customized Quick Preview might include kerning pairs you’re concerned about, the
alphabet, numbers, etc.

A customized quick preview displays your text at the size you prefer.

Using Font Reserve — 101

Using Quick Preview



Using Full Preview

To preview a font at different sizes and in different contexts, you can use the Full
Preview feature. For example, you can preview a paragraph of text with different point
size and leading combinations. You can display two previews to compare fonts — all
without activating the fonts and using them within an application.

The Preview dialog box with the Paragraph panel showing.

Displaying Full Previews
You can display a Preview for a single font, or open individual Previews for multiple-
selected fonts, fonts in a family, fonts in a suitcase, or fonts in a set. Select the fonts,
then double-click an icon or click the Preview button on the Browser. This opens a
Preview, with the default panel showing, for each selected font.

To display a Preview with a specific panel showing, choose an option from the View
menu or press one of the keyboard commands listed in the menu:

Menu Command Keyboard Command

Show Character Map Command+Shift+C

Show Info Command+Shift+I

Show Kerning Command+Shift+E

Show Paragraph Command+Shift+P

Show Sample Command+Shift+S

Show Waterfall Command+Shift+W
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Understanding Previews
The Preview provides six panels of information about each font. Click an icon in the
scroll list at left to control which panel displays. The panels provide the following
information:

• The Info panel displays the font’s PostScript Name, Menu Name, Family Name, File
Name, Default Foundry, Custom Foundry (assigned through the Foundry menu),
Kind, Default Label, Custom Label (assigned through the Label menu), Version,
FOND ID, Kerning Checksum, Outline File Size, Suitcase File Location, and Outline
File Location. To open the folder containing the previewed font, click the Show Files
on Desktop button.

Note: If you preview a PostScript outline font, only the Info panel is available.

• The Character Map panel displays all the characters available in a font. See
“Previewing Special Characters” on page 107 for more information.

• The Kerning panel displays all the kerning pairs in the font and the associated kern-
ing values.

• The Paragraph panel displays several paragraphs so you can preview the color of the
type. To experiment with different point sizes and leading, you can enter new values
in the Pointsize and Leading fields.

• The Sample panel displays one sentence. To experiment with different point sizes,
you can enter a new value in the Pointsize field.

• The Waterfall panel displays a string of text at 7, 9, 12, 14, 18, 24, 36, and 48 points
for comparison. To compare different point sizes, you can enter new values in the
eight point size fields at the top of the panel.

Closing Previews
To close a Preview dialog box: choose Close Window from the File menu, click 
the Preview’s close box, or press Command+W. To close all open Previews press
Command+Option+W or press the Option key while you click any Preview’s
close box. To prevent Preview windows from opening (for example, when you acci-
dentally double-click a set or family), press Command+Period.
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Customizing the Full Preview
By default, the Preview may not show a panel that is useful to you, or the text used to
preview the fonts may not represent your content well. You can customize the panel
that is displayed by default, and you can customize the text used in the Paragraph,
Sample, and Waterfall panels. To customize the Preview feature:

1 Choose Preferences from the Edit menu.

2 Click the Previews icon in the scroll bar at left.

3 To specify the panel that is showing when you first open the Preview, choose an
option from the Default Panel pop-up menu.

The Previews panel of the Preferences dialog box.

4 Click the Paragraph icon to modify the text displayed in the Paragraph panel of the
Preview:

• Enter or paste new text in the Paragraph Text field.

• Specify a new point size by entering a value up to 256 in the Pointsize field or
choosing an option from the pop-up menu.

• Specify the space between lines in the paragraph by entering a value in the
Leading field or choosing an option from the pop-up menu.

• Specify the default width of the Paragraph panel by entering an inch value in the
Width field. If you resize the Paragraph panel, then click the zoom box, the panel
will revert to this width.
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5 Click the Sample icon to modify the text displayed in the Sample panel of the
Preview.

• Enter or paste new text in the field.

• Specify a new point size by entering a value up to 256 in the Pointsize field or
choosing an option from the pop-up menu.

• Specify the default width of the Sample panel by entering an inch value in the
Width field. If you resize the Sample panel, then click the zoom box, the panel
will revert to this width.

The Sample panel in the Preferences dialog box.

The Sample panel in the Preview.
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6 Click the Waterfall icon to modify the text displayed in the Waterfall panel of the
Preview. Enter or paste new text in the Waterfall Text field.

The Waterfall panel in the Preferences dialog box.

The Waterfall panel in the Preview.

7 Click OK to implement the changes. The changes will not affect Previews that are
currently open.
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Previewing Special Characters

With Font Reserve, you no longer need additional software such as KeyCaps or PopChar
to locate special characters. Font Reserve provides a Character Map that displays all the
characters in a font, allows you to copy and paste characters into documents, and pro-
vides the keyboard commands for entering characters.

Press Command+Shift+C to display the Character Map for a selected font.

Displaying the Character Map
To display a Character Map, select a font and choose Show Character Map from the
View menu or press Command+Shift+C. A Preview displays with the Character Map
panel showing. The Character Map works as follows:

• Scroll or resize the dialog box as necessary to locate the special character you need.

• Click a character to display its keyboard command in the Keypress field. Click and
drag to point at characters and show their keyboard commands as you drag.

• By default, the characters are 24 points. To change the point size, enter a value up to
256 points in the field or choose an option from the pop-up menu.
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Pasting Special Characters into Documents
You can copy and paste special characters from the Character Map into a document.
For example, you might paste a Zapf Dingbats check box ❏ character into a line of
Garamond text. To do this:

1 Click a character in the Character Map to display it in the Keypress field.

2 Press Command+C to copy the character to the Clipboard.

3 Click in the text where you want to insert to the character. Press Command+V.

If the font you’re previewing is active, the character will display in that font. If the font
is not active, the character will display according to the font of the surrounding text.
Once you activate the font, the character will display correctly.

Customizing the Character Map
You can change the default point size of the characters displayed in the Character Map
by specifying a new value in the Pointsize field in the Character Map panel of the
Preferences dialog box (Edit menu). You can enter a value up to 256 points or choose
an option from the pop-up menu.

The Character Map panel of the Preferences dialog box.
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Printing Fonts in a Type Book

To print a sample of fonts for presentation to a client or for your own reference, you
can print a type book. Font Reserve provides several templates for printing the book,
and allows you to customize the pages. The controls for printing a type book are in the
Specimen menu, and you select fonts for printing in the Browser.

Customizing the Template
Font Reserve allows you to specify the first page number, header text, footer text, and
font used in the template you choose. Most of the specimen templates provided with
Font Reserve have space reserved on each page for customizable headers and footers.
For example, the header might contain the name of the project or client, or the name
of the fonts you’re printing (such as, “Bitstream Fonts”). The footer might contain the
page number and the date you printed the type book. To customize the template:

1 Choose Settings from the Specimen menu. The Specimen Book Settings dialog box
displays.

The Specimen Book Settings dialog box.

2 To specify the first page number for the book, type a value in the Starting Page
Number field. For example, if you’re adding to a four-page book, enter 5.
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3 To customize the text printed at the top of the page, enter or paste characters in the
Header Text field. The header can include text and macros for date, time, font attrib-
utes, etc. See the next section, “Entering Macros for Header and Footer Text,” for
more information. For example, you might add the name of the client and font.

4 To customize the text printed at the bottom of the page, enter or paste characters in
the Footer Text field. The footer can include text and macros for page number, date,
time, font attributes, etc. See the next section, “Entering Macros for Header and
Footer Text,” for more information. For example, you might add the name of your
design firm, followed by the page number.

5 To select a font for the header, footer, and other descriptive text in the type book,
choose an option from the Use pop-up menu, which lists all your active fonts.
Details about the font you choose are listed in the Default Font field.

Note: If the font you want to use is not active, click OK to save your settings with
the Specimen Book Settings dialog box. Activate the font, open the Specimen Book
Settings dialog box again, and select the font.

6 Click OK to save your changes.

Note: To revert the Specimen Book Settings dialog box to its original settings, click
the Use Defaults button.

Entering Macros for Header and Footer Text
The Specimen Book Settings dialog box lets you customize the header and footer of
your type book by entering text and macro expressions. A macro is a character string
enclosed in brackets that is replaced by the appropriate text when pages are composed.
Macros expand into date, time, page number, and font attributes.

For example, entering “Printed on: <DATE>” in the Header Text field prints the words
“Printed on: Oct 15, 1999” at the top of each page of your type book.

Note: You may wish to enter your text and macros into a word processor so you can
view the entire string, then paste the text into the scrollable Header Text and Footer
Text fields.
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Use the less than < and greater than > symbols to enclose the macro expressions. You
can enter the following macros in the Header Text and Footer Text fields:

Macro Expression Example

<DATE> Aug 15, 1999

<DATE FORMAT=SHORT> Aug 15, 1999

<DATE FORMAT=LONG> August 15, 1999

<DATE FORMAT=ABBREV> 8/15/99

<TIME> 12:35 PM

<TIME SECONDS=FALSE> 12:35 PM

<TIME SECONDS=TRUE> 12:35:05 PM

<PAGE> 12

<POSTSCRIPTNAME> Palatino-Bold

<FAMILYNAME> Palatino

<MENUNAME> B Palatino Bold

<FOUNDRY> Adobe Systems

<KIND> TrueType

<CLASS> Sans Serif

<FONDID> 1200

<PRIMARYOWNER> Speedy Printing Service, Inc.

<VERSION> 001.002

<LOCATION> Vault

<KERNINGTABLECHECKSUM> 543,710

<OUTLINEFILESIZE> 28,120

<VOLUMENAME> Macintosh HD

<POINTSIZE> 12

Using Font Reserve — 111

Printing Fonts in a Type Book



Choosing Fonts to Print
Once you’ve customized the template, you select fonts in the Browser that you want to
print. The fonts do not have to be active to be printed in a type book. You can select font
references or fonts in the Sets area, or you can choose fonts, families, and suitcases in the
Fonts area. Click to select an item, Shift+click to select multiple items, and marquee to
select a range of continuous items.

The Font Reserve database can help you organize your type books. For example, to
print a type book consisting of all your Bitstream fonts in class order, use a filter to
display only your Bitstream fonts; click the Class column in the Browser to sort the
Bitstream fonts by class. Then, press Command+A to select all these fonts for your
type book.

Note: If you select a font added via the alias method, and the original font file is not
available, you cannot print the font.

RegularJoe, RemedyDouble, and RemedySingleExtras selected to print.

Sending Selected Fonts to Print
To send the selected fonts to print, choose a template from the lower half of the
Specimen menu. Font Reserve composes the pages, then displays a preview window.

Templates listed in the lower half of the Specimen menu.
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Use the First, Prev, Next, Last, and Go To buttons and the Page Grabber Hand tool to
review your type book before printing it. To change the view scale of the preview, click
the Scale menu and choose Fit in Window, 50%, 75%, Actual Size, 200%, 400% or
800%. You can also click the Zoom tool to increase the view or Option+click the
Zoom tool to decrease the view. To print the type book click Print.

A preview of a type book, ready to print.
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Importing Specimen Templates
Templates for printing type books are provided by DiamondSoft and stored in the
Specimen Templates folder in the Font Reserve 2.0 Folder. As more Font Reserve tem-
plates become available in future releases of Font Reserve or through the Font Reserve
web site, you can import them. To import specimen books:

1 Choose Edit Specimen Templates from the Specimen menu.

The Edit Specimen Templates dialog box.

2 Click the Import button.

3 Navigate to the new specimen templates.

The Edit Specimen Templates dialog box.

4 Select a template file and click Open.

5 Click OK to return to the Browser. The imported templates will be added to the
Specimen menu and available for printing.
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Generating Reports of Font Information

To assist in managing systems and fonts, Font Reserve provides a reporting feature.
Using options in the Reports submenu of the File menu, you can extract information
about the computer environment, extract information about selected fonts, list which
sets selected fonts are used in, and list how many fonts are in the database.

Environment Report
To aid in troubleshooting, you can view the system environment in which Font Reserve
is operating. Choose File ➛ Reports ➛ Environment. Font Reserve displays the
Environment Report dialog box, which lists details such as the CPU, Server Memory,
Volumes, and contents of the Startup folder, Control Panels folder, Extensions folder,
and Fonts folder. You can view the report, print it, or export it as a text file.

The Environment Report dialog box.
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Tab-Separated Font Report
You can generate a report of information for fonts you select in the Browser, then print
the report or export it as tab-delimited text. If you export the report as a text file, you
can import it into a database such as FileMaker Pro. Systems administrators might use
this information to track font versions and licenses.

To generate a report of font information, select the fonts in the Fonts area of the
Browser. Choose File ➛ Reports ➛ Font Info. Font Reserve displays the Tab-Separated
Font Report dialog box, which lists the name, kind, foundry, class, version, and primary
owner of selected fonts. You can view the report, print it, or export it as a text file.

The Tab-Separated Font Report dialog box.

Sets Using Fonts Report
You can generate a report to determine which sets selected fonts are used in. For
example, if you want to delete a font, you can see if it will affect any sets. To find out
which sets fonts are used in, first select the fonts in the Fonts area of the Browser.
Choose File ➛ Reports ➛ Sets Using Fonts. Font Reserve displays the Sets Using
Fonts Report dialog box, which lists each font’s PostScript name, kind, foundry, ver-
sion, along with the sets the fonts are used in. You can view the report, print it, or
export it as a text file.
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The Sets Using Fonts Report dialog box.

Catalog Summary Reports
You can generate a report that tells you how many fonts you have in your database.
Choose File ➛ Reports ➛ Summary. Font Reserve displays the Catalog Summary
Report dialog box, which lists the total number of fonts in your database, the number
of sets you have, and the number of fonts you have within each kind, class, foundry,
and owner.

The Catalog Summary Reports dialog box.
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Chapter 8: Managing Fonts

Sophisticated users can sort, find, and manage fonts using the class, owner, and

foundry features available in the Browser:

• A font’s class defines its style — serif, sans serif, old style, etc. Sorting fonts by

class helps designers quickly find a font appropriate to their designs.

• The ownership feature helps production departments and service bureaus

organize fonts according to clients and jobs.

• A font’s foundry is the company that licenses the font. You can add foundries

and change the foundry assigned to a font as necessary.

The Class, Owner, and Foundry menus work similarly, allowing you to change

the specification applied to each font. An Edit command in each menu lets you

customize the list of options and share your list with other users.
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Working with Classes

A font’s class indicates its style — serif, sans serif, script, ornamental, etc. You can sort
fonts by class, making it easy to find the appropriate font for a design, or print a type
book consisting of specific styles.

When you add fonts, Font Reserve assigns a class based on the font name and other
criteria. You can change the class assigned to a font if it’s incorrect, and you can create
your own classes to encompass all your different styles of fonts. You can import and
export customized lists of font classes to share them among users.

Default Font Classification
When fonts are added to Font Reserve, they are automatically assigned a class. A font’s
class is determined by comparing the font’s family name to an internal database of
font family names and their classifications.

The default font class is not always correct — sometimes due to limitations of the data-
base and sometimes due to the subjective nature of font classification. Although the
classes are based on conventional typographic principles, font classification is not a sci-
ence. That’s why Font Reserve lets you change a font’s class and create your own classes.

By default, Font Reserve assigns one of the classes in the default Class menu:

The Class menu.
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• A Blackletter typeface, such as Blackmoor, is characterized by medieval or old English
lettering, with ornate capitals, roughly diamond-shaped serifs, and thick, mostly-
vertical strokes. Uncial, generally perceived as celtic or Irish, is also an archaic form,
with rounded letters and calligraphic qualities. Cloister Black is a blackletter type-
face, and American Uncial is a common uncial typeface.

• A Serif typeface, such as Sprocket, is characterized by the finishing strokes on char-
acters that help lead the eye across a line. The Serif class includes only serif fonts
that do not fit well into a sub-class such as oldstyle, transitional, modern, clarendon,
or slab. This includes typefaces with unusual serifs, such as the triangular serifs of
Versailles.

• An Oldstyle serif typeface, such as Garamond, is characterized by low- to moderate-
contrast, diagonal stress, and serifs with a rounded join to the letter. Goudy Oldstyle
and Garamond are common oldstyle typefaces.

• A Transitional serif typeface, such as ATEsprit, is characterized by vertical stress
and slightly higher contrast than old style typefaces, combined with horizontal serifs
and greater symmetry. Baskerville is a common transitional typeface.

• A Modern serif typeface, such as Fenice, is characterized by vertical stress and
strong contrast. Modern serifs and horizontals are very thin, almost hairlines. The
serifs join to letters with an angle rather than a rounded join. Bodoni is the most
common modern typeface.

• A Clarendon (or ionic) typeface, such as Bookman, is an offspring of the slab
serif typefaces in which the serifs are bracketed, and the letterforms are more akin to
sans serif letters, although contrast is usually low. They are popular for newspaper
work because their sturdy serifs hold up well under adverse printing conditions.
Besides Clarendon itself, Bookman is the most common Clarendon typeface.

Fonts in the Clarendon class.
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• A Slab serif typeface, such as City, is characterized by block-like rectangular serifs,
sticking out horizontally or vertically, often the same thickness as the body strokes.
The serifs join with an angle rather than a rounded join. The letters have little or no
contrast, and they often look like sans serif letters with the slab-like serifs tacked on.
Rockwell and Glypha are common slab serif typefaces.

• A Sans serif typeface, such as Futura, is characterized by little to no contrast and no
serifs. The sans serif class includes only sans serif fonts that do not fit in the
grotesque and humanist classes. This includes geometric designs such as Avant
Garde, and art deco faces such as Bodega Sans and ITC Anna.

• A Grotesque sans typeface, such as Univers, is the original sans serif letterform —
functional and utilitarian. The term is a classification, and not a judgment of beauty.
Helvetica and Franklin Gothic are common grotesques.

• A Humanist sans typeface, such as Gill Sans, is a sans serif typeface inspired by
other letterforms, commonly serif or inscriptional models. Syntax and Optima are
humanist sans serifs.

• A Script typeface, such as Zapf Chancery, is based on hand lettering, whether with a
broad-edged pen, a flexible steel nib, or a brush. This includes everything from chil-
dren’s handwriting to beautiful and ornate Elizabethan roundhand. Common scripts
include Shelley, Brush Script, Present Script, and Mistral.

• An Ornamental typeface, such as Algerian, is unusual or ornate, and either
doesn’t fit cleanly into other categories or is really only suitable for use at display
sizes. This includes inline, outline, and engraved typefaces. Examples include
Desdemona, Colonna, and Edda.

• A Symbol/Pi typeface, such as ✺❁❐❆ ✤❉■❇❂❁▼▲ (Zapf Dingbats), is a collec-
tion of symbols or pictures assembled into a font. Wingdings is a common symbol/pi
typeface.

Fonts in the Symbol/Pi class.
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Viewing and Changing a Font’s Class
By default, the Browser includes a Class column that shows the class assigned to each
font. If the Class column is not displayed, check Class in the Columns panel of the
Preferences dialog box (Edit menu).

To change the class, select the fonts and choose an option from the Class menu:

• Choose one of the default classes, or one of the classes you create from the lower
portion of the menu.

• Choose None to remove a font’s class entirely.

• Choose Default to reapply the class initially assigned by Font Reserve.

The Class menu.

Tip: To quickly change a font’s class, Command+click the font’s class in the Browser,
then choose an option from the Class pop-up menu.

When you change a font’s class, all corresponding font references assume the new
class. When you change a font reference’s class, the original font, and all other corre-
sponding font references assume the new class.
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Creating New Classes
If you need additional classes to categorize all your fonts, you can create up to 128 cus-
tom classes. To create a custom class:

1 Choose Edit Classes from the Class menu.

2 Click the New button in the Classes dialog box, or press Command+Option+N.

The Classes dialog box.

3 Type a name for the class in the Name field.

The Class Editor dialog box.

4 Click the Change button to display a color wheel and assign a color to the class. The
color is displayed next to the class in the Class menu.

5 Select a color and click OK.

6 Click OK to create the new class.

7 Click OK to return to the Browser; your custom class displays in the Class menu
and may be assigned to fonts.
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Editing Custom Classes
You cannot edit the default classes, but you can change the name and color of custom
classes. The changes apply to all the fonts with that custom class applied.
To edit a custom class:

1 Choose Edit Classes from the Class menu.

2 Select the class you want to edit. Type the first letters of the class name to jump to it
quickly.

3 Click the Edit button or double-click the class name.

4 Change the class name or color.

5 Click OK to change the custom class definition.

6 Click OK to return to the Browser.

Deleting Classes
You cannot delete the default classes, but you can delete custom classes. When you
delete a custom class, fonts with that class applied revert to the default classification.
To delete a custom class:

1 Choose Edit Classes from the Class menu.

2 Select the custom classes you want to delete. Click to select a class, Command+click to
select multiple classes, and Shift+click to select a range of continuous classes.

3 Click the Delete button.

4 Click OK to return to the Browser.

Exporting Custom Classes
To share your custom classes with other Font Reserve users, you can export all or
selected classes as a file. To export custom classes:

1 Choose Edit Classes from the Class menu.

2 Select the custom classes you want to export. Click to select a class, Command+click
to select multiple classes, and Shift+click to select a range of continuous classes.
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3 Click the Export button.

4 Use the standard directory dialog box to create a new folder or navigate to a location
for the exported classes.

5 Type a name for the exported classes in the Class File field.

The Class File field.

6 Click Save or press Command+S to create a file of exported classes.

7 Click OK to return to the Browser.

The class file is in the location you specified and looks like this . You can email it to
other users or make it available on a network.

Importing Custom Classes
To use custom classes from another Font Reserve user, you can import their file of cus-
tom classes. First, copy the class file to your hard drive or make sure you can access it
over a network. To import custom classes:

1 Choose Edit Classes from the Class menu.

2 Click the Import button.

3 Use the standard directory dialog box to navigate to the class file, which will look
like this .

4 Select the class file and click Open.

Note: If one of your custom classes has the same name as one of the imported cus-
tom classes, an alert displays. Click OK to override your classes with the imported
classes.

5 Click OK to return to the Browser.
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Working with Owners

An owner is an indication of who supplied a font or which jobs use the font. If you are
constantly receiving fonts from different sources, the ownership feature helps you track
those fonts. Every font in Font Reserve must have one owner, and it may have multiple
owners. When fonts are added to Font Reserve, they automatically receive an owner —
either the default owner or an owner you specify.

Font Reserve supplies a default owner and allows you to create an editable list of own-
ers. Once you’ve created owners, you can assign additional owners to fonts, remove
owners from fonts, and sort or search for fonts by owner. Using this mechanism, you
can track fonts from different clients, allowing you to easily activate, create sets from,
or even delete all of a client’s fonts.

Font Reserve manages owners and fonts efficiently:

• If you remove an owner from a font, and that owner is the sole owner of the font,
then the font is deleted from Font Reserve (after a warning dialog box).

• If you remove an owner from a font owned by multiple owners, then only the select-
ed owner is removed, and the font remains in Font Reserve.

• If you add a font from a client that already exists in Font Reserve, the font will not
be added again (since Font Reserve does not add duplicate fonts), but the new
owner will be added to the list of owners for that particular font.

Note: Remember that Font Reserve considers location as a criteria in determining
whether fonts are duplicates. If you add two copies of the same font via the alias
method, both fonts will be added because they are in different locations. The owner-
ship feature provides a quick method for determining the difference between two fonts
that seem to be the same although they have different locations.

Managing Fonts through Owners
Take a look at the ownership features in a service bureau scenario. Say ABC Client
supplies the fonts Helvetica Condensed Black and Garamond Book with their job.
The service bureau has several copies and versions of these two fonts. To ensure that
the client’s fonts are used to print their job, the service bureau first creates an owner
called ABC Client. Then, the service bureau adds the fonts via the alias method and
assigns the primary owner ABC Client.
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To locate the fonts, the service bureau uses a Quick Filter to find the fonts owned by
ABC Client. The service bureau activates those fonts, ensuring that no other copies of
Helvetica Black Condensed and Garamond Book are active, then prints the job.

Later, when finished with the project, the service bureau wants to remove the client’s
fonts from Font Reserve. To do so, the operator uses the Quick Filter feature again to
display all fonts owned by the client. The operator selects all these fonts and deletes
them from Font Reserve. If the service bureau isn’t expecting to work with the client
again soon, the operator can delete the owner, thereby deleting their fonts.

Creating New Owners
To start using the ownership features efficiently, you need to develop a list of owners
that encompasses all your users, clients, jobs, etc. You can create an unlimited number
of owners. To create an owner:

1 Choose Edit Owners from the Owner menu.

2 Click the New button in the Owners dialog box, or press Command+Option+N.

The Owners dialog box.

3 Type a name for the owner in the Name field.

4 If you wish, type a description of the owner in the Info field.
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The Owner Editor dialog box.

5 Click OK to create the new owner.

6 Click OK to return to the Browser; your new owner displays in the Owner menu.

Assigning the Initial Owner
When you add fonts to Font Reserve, you can assign an initial owner to the fonts. If
you do not assign an owner, Font Reserve will use the default owner. (The default
owner is the name of the machine on which Font Reserve was first launched.) 

If you add duplicate fonts to the vault, but specify a different owner, the new owner is
added to the existing font’s owner list. Duplicate fonts are not added to the vault.

You can specify the initial owner as you add fonts, or before you add fonts. If you
have Always open this window checked in the Adding Fonts panel, simply drag fonts
into Font Reserve to specify the ownership. If you have Always open this window
unchecked, open the Adding Fonts panel of the Preferences dialog box (Edit menu)
and specify the owner before you add fonts. To assign an initial owner to fonts:

1 Choose an owner for the fonts from the Add Ownership pop-up menu. If you need
to create a new owner on the fly, you can choose Edit Owners.

The Add ownership pop-up menu.
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2 Check Make this the primary owner if you want this owner displayed in the Owner
column of the Browser for the fonts you’re adding.

3 Confirm the Font Files and Expert Options settings, then click OK to add the fonts
(or change the preference).

Assigning Additional Owners
After you add fonts with their initial owner, you can assign more owners. A font can
have as many owners as you need. To assign an additional owner to fonts:

1 Select the fonts or sets in the Browser. Click to select an item, Shift+click to select
multiple items, and marquee to select a range of continuous items.

2 Choose Add Ownership from the Owner menu.

3 Select an additional owner from the Owner pop-up menu.

The Add Ownership dialog box.

4 Check Make this the primary owner if you want this owner displayed in the Owner
column of the Browser for the selected fonts.

5 Click OK to assign the owner to the fonts.

Changing the Primary Owner
Each font has a primary owner that controls which owner is displayed in the Owner
column of the Browser; this is the only difference between an owner and a primary
owner. If the Owner column is not displayed, check Owner in the Columns panel of
the Preferences dialog box (Edit menu). You can also search for fonts based on the
primary owner.
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To change the primary owner of fonts, simply select the fonts and choose an owner
from the Owner menu. You can only choose from current owners of the selected
fonts — those that are bold in the Owner menu.

You can change a font’s primary owner by selecting an option from the lower portion 
of the Owner menu.

Viewing Ownership
You can view the primary owner of a font through the Browser, or you can view all the
owners of a font through the Owner menu.

• To view a font’s primary owner, check Owner in the Columns panel of the
Preferences dialog box (Edit menu). This displays the Owners column in the
Browser, which displays the primary owner for each font.

• To view all the owners of a font, select the font and display the Owner menu. You
can click the Owner menu on the menu bar or Command+click the font’s owner
displayed in the Owner column.

Command+clicking a font’s owner in the Browser displays the Owner menu.
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Removing Owners
Font Reserve lets you remove owners from fonts, which is generally useful for deleting
all the fonts owned by a specific owner. To do this, first use the Quick Filter to find all
that owner’s fonts. Then, select all the fonts and remove the owner. If the fonts are
owned exclusively by that owner, they will be deleted.

You might also remove an owner from a font when that owner no longer needs the
font — for example, if you’re finished printing that owner’s job. The font will maintain
its other owners. To remove an owner from a font:

1 Select the fonts or sets in the Browser.

2 Choose Remove Ownership from the Owner menu.

3 Click Only to remove a specific owner from a font, then choose the owner to remove
from the Owner pop-up menu.

Click All except to remove all but one owner, then choose the owner to maintain
from the Owner pop-up menu.

The Remove Ownership dialog box.

4 Click OK to remove the owners from the selected fonts.

Note: If the owner you’re removing is the sole owner of a font, an alert warns you that
the font will be deleted from Font Reserve as well. (If the fonts reside in the vault, they
will be deleted from your computer as well.) 

To continue removing the owners and delete the fonts, click Delete. To cancel remov-
ing the owners and prevent font deletion, click Don’t Delete. If you want to remove an
owner without deleting the fonts, assign an additional owner to the fonts before
removing the owner.
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Editing the Owners List
You can edit the default owner and any owners you create. When you change the name of
an owner, the new name is applied to all fonts with that owner. To edit an owner:

1 Choose Edit Owners from the Owner menu.

2 Select the owner you want to edit.

3 Click the Edit button or double-click the owner name.

4 Change the owner name or information.

5 Click OK to change the owner definition.

6 Click OK to return to the Browser.

Deleting Owners
You cannot delete the default owner, but you can delete the owners you create. When
you delete an owner, the owner is deleted from the owners list and removed as an
owner from any fonts. To delete an owner:

1 Choose Edit Owners from the Owner menu.

2 Select the owner you want to delete. Click to select an owner, Command+click to
select multiple owners, and Shift+click to select a range of continuous owners.

3 Click the Delete button.

Note: If one of the selected owners was the sole owner of a font, an alert warns you
that the font will be deleted from Font Reserve as well. (If the fonts reside in the vault,
they will be deleted from your computer as well.) 

To continue deleting the owners and the fonts, click Delete. To cancel deleting the
owners and prevent font deletion, click Don’t Delete. If you want to delete an owner
without deleting the fonts, assign an additional owner to the fonts before deleting
the owner.
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The alert that displays when deleting the sole owner of fonts.

4 Click OK to return to the Browser.

Exporting the Owners List
To share your owners list with other Font Reserve users, you can export all or selected
owners as a file. To export owners:

1 Choose Edit Owners from the Owner menu.

2 Select the owners you want to export. Click to select an owner, Command+click to
select multiple owners, and Shift+click to select a range of continuous owners.

3 Click the Export button.

4 Use the standard directory dialog box to create a new folder or navigate to a location
for the exported owners.

5 Type a name for the exported owners in the Owner File field.

The Owner File field.
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6 Click Save or press Command+S to create a file of exported owners.

7 Click OK to return to the Browser.

The owner file is in the location you specified and it looks like this . You can email
it to other users or make it available on a network.

Importing the Owners List
To use an owners list from another Font Reserve user, you can import their file of
owners. First, copy the owner file to your hard drive or make sure you can access it
over a network. To import owners:

1 Choose Edit Owners from the Owner menu.

2 Click the Import button.

3 Use the standard directory dialog box to navigate to the owner file, which will look
like this .

4 Select the owner file and click Open.

Note: If one of your owners has the same name as one of the imported owners, an
alert displays. Click OK to override your owners (and their information) with the
imported owners.

5 Click OK to return to the Browser.
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Working with Foundries

In Font Reserve, the foundry classification is the name of the company that licensed
the font to you. The foundry is not necessarily the original designer of the font. For
example, if you license fonts from Adobe, the foundry is listed as Adobe — even
though many fonts in the Adobe library were created by other design houses.

When you add fonts, Font Reserve attempts to identify the foundry. You can change
the foundries assigned to a font if it’s incorrect, and you can add foundries to encom-
pass the designers of all your fonts. You can import and export customized lists of font
foundries to share them among users.

Default Foundry
When fonts are added to Font Reserve, they are automatically assigned a foundry.
If Font Reserve is unable to determine a font’s foundry — as occasionally happens
with shareware fonts, fonts from independent font designers, and fonts from smaller
or newer font foundries — the foundry is listed as Unknown.

If you sort fonts by foundry, you may want to use the foundry features to ensure that
all your fonts have the correct foundry listed. By default, Font Reserve assigns one of
the foundries in the Foundry menu:

Part of the Foundry menu.
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Viewing and Changing a Font’s Foundry

By default, the Browser includes a Foundry column that shows the foundry assigned
to each font. If the Foundry column is not displayed, check Foundry in the Columns
panel of the Preferences dialog box (Edit menu).

To change the foundry, simply select the fonts and choose an option from the
Foundry menu:

• Choose one of the default foundries, or one of the foundries you create, from the
lower portion of the menu.

• Choose None to remove a font’s foundry entirely.

• Choose Default to reapply the foundry initially assigned by Font Reserve. If you
have deleted that foundry, the font’s foundry is listed as Unknown.

Part of the Foundry menu.

Tip: To quickly change a font’s foundry, Command+click the font’s foundry in the
Browser, then choose an option from the Foundry pop-up menu.

When you change a font’s foundry, all corresponding font references assume the new
foundry. When you change a font reference’s foundry, the original font, and all other
corresponding font references assume the new foundry.
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Creating New Foundries
If you need additional foundries to indicate the designer of all your fonts, you can cre-
ate an unlimited number of custom foundries. To create a custom foundry:

1 Choose Edit Foundries from the Foundry menu.

2 Click the New button in the Foundries dialog box, or press Command+Option+N.

The Foundries dialog box.

3 Type a name for the foundry in the Name field.

The Foundry Editor dialog box.

4 Click OK to create the new foundry.

5 Click OK to return to the Browser; your custom foundry displays in the Foundry
menu and may be assigned to fonts.
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Editing Foundries
You cannot edit the default foundries, but you can change the name of custom
foundries. The changes apply to all the fonts with that foundry applied. To edit 
a foundry:

1 Choose Edit Foundries from the Foundry menu.

2 Select the foundry you want to edit. Type the first letters of the foundry name to
jump to it quickly.

3 Click the Edit button or double-click the foundry name.

4 Change the foundry name.

5 Click OK to change the custom foundry definition.

6 Click OK to return to the Browser.

Deleting Foundries
You cannot delete the default foundries, but you can delete custom foundries. When
you delete a custom foundry, fonts with that foundry applied revert to their default
foundry. To delete a custom foundry:

1 Choose Edit Foundries from the Foundry menu.

2 Select the custom foundries you want to delete. Click to select a foundry,
Command+click to select multiple foundries, and Shift+click to select a range of con-
tinuous foundries.

3 Click the Delete button.

4 Click OK to return to the Browser.

Exporting Custom Foundries
To share your custom foundries with other Font Reserve users, you can export all or
selected foundries as a file. To export custom foundries:

1 Choose Edit Foundries from the Foundry menu.

2 Select the custom foundries you want to export. Click to select a foundry,
Command+click to select multiple foundries, and Shift+click to select a range 
of continuous foundries.
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3 Click the Export button.

4 Use the standard directory dialog box to create a new folder or navigate to a location
for the exported foundries.

5 Type a name for the exported foundries in the Foundry File field.

The Foundry File field.

6 Click Save or press Command+S to create a file of exported foundries.

7 Click OK to return to the Browser.

The foundry file is in the Templates folder and it looks like this . You can email it to
other users or make it available on a network.

Importing Custom Foundries
To use custom foundries from another Font Reserve user, you can import their file of
custom foundries. First, copy the foundry file to your hard drive or make sure you can
access it over a network. To import custom foundries:

1 Choose Edit Foundries from the Foundry menu.

2 Click the Import button.

3 Use the standard directory dialog box to navigate to the foundry file, which will look
like this .

4 Select the foundry file and click Open.

5 Click OK to return to the Browser.
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Saving Classes, Owners, and Foundries

The classes, owners, and foundries you create are saved in the Catalog folder inside the
Font Reserve Database folder. If you create a new database, it will not include any of
your classes, owners, or foundries. (You might create a new database while installing a
new system, to replace a corrupted database, or simply to contain different fonts.) If you
have spent a great deal of time customizing the classes, owners, and foundries lists, you
may wish to maintain some of that work while using a new database.

Using the Export buttons in the Classes, Owners, and Foundries dialog boxes, you
can export your lists — or select items from those lists. You can store these files on
another volume as backups or for use with other databases. When a new or different
database is active, use the Import buttons in the Classes, Owners, and Foundries dia-
log boxes to add your existing lists to the default lists.

The Classes and Owners dialog boxes let you export selected items or their entire lists.

The Foundries dialog boxes lets you export selected foundries or all your foundries.
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Another way to maintain your classes, owners, and foundries for use with another data-
base is to backup the Catalog folder inside the Font Reserve Database folder. In addition
to storing classes, owners, and foundries, the Catalog folder stores information about
the sets you’ve created and the fonts you’ve added to Font Reserve. If you create a new
database, you can replace the new Catalog folder with your backup Catalog folder.

The Catalog folder inside the Font Reserve Database folder.
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Chapter 9: Managing Sets

Font Reserve allows you to group fonts into “sets” for specific clients, jobs, or tem-

plates. Sets, which display in the top portion of the Browser, look and act like

Mac OS folders. The sets consist of pointers, called font references, to fonts in

Font Reserve. Since sets don’t contain fonts, they consume very little hard disk

space. You can create as many sets as you need, place sets within other sets, and

place the same font in more than one set.

Once fonts are in a set, you can manipulate the fonts as one unit. For example,

you can preview all the fonts, activate all the fonts, deactivate all the fonts, or copy

all the fonts to the Finder for delivery to a service bureau. In addition, you can

import and export set definitions to share with other users.
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Creating Sets

Font Reserve includes one default set, the System Fonts set, and allows you to create
additional sets. You can create new, empty sets or create sets from fonts that you are
adding to Font Reserve. Once you have sets, you can add and remove font references
from them at any time.

The System Fonts Set
Font Reserve automatically creates a System Fonts set, which will list all the fonts in
your System Fonts folder. To compile the initial System Fonts set, choose Scan System
Folder from the File menu. The first time you launch the Browser, and each time you
make changes to the System Fonts folder thereafter, Font Reserve prompts you to res-
can the folder to update the System Fonts set.

Fonts in the System Fonts set are not managed by Font Reserve. You cannot delete or
rename the System Fonts set, but you can copy the fonts to the Finder, preview the
fonts, and print the fonts in a specimen book. See “Handling System Fonts” on page
53 for more information.

Creating an Empty Set
You can create unlimited sets and place an unlimited number of font references in
each set. To create and name a new set:

1 Choose New Set from the File menu, click the New button on the Browser, or press
Command+N.

2 Type a descriptive name for the set, using up to 32 characters.

New sets are highlighted automatically for renaming.

Note: Any time you wish to change a set’s name, simply click on the name to highlight
it, the same way you change the name of a folder or file at the Finder.
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Adding Font References to a Set
You can place an unlimited number of font references in a set and you can add font
references at any time. To add font references to a set:

1 Select the fonts you want to add to the set. Click to select a font, Shift+click to select
multiple fonts, and marquee to select a range of continuous fonts.

2 Drag and drop the fonts on the set.

Dragging fonts to a set.

Tip: If the set you’re adding fonts to is not displayed in the Sets area, the Sets area will
scroll. To scroll up, drag the fonts to the title bar of the Sets area (for example, drag it
on top of the Name column). To scroll down, drag fonts to the horizontal scroll bar
below the Sets area.

Creating a Set while Adding Fonts to Font Reserve
You can create a set for fonts within a folder or volume as you add them to Font
Reserve. Font Reserve creates a new set for each “top level” volume or folder you drag
into the Sets area. For example, say you receive a folder called “ABC Client Brochure,”
which contains three subfolders called “Documents,” “Graphics,” and “Fonts.” If you
drag the “ABC Client Brochure” folder to the Sets area, Font Reserve creates a set
called “ABC Client Brochure” from the fonts inside the “Fonts” folder.
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The fonts are added to Font Reserve and listed in the Fonts area, while the new set
contains references to those fonts. To create a set while adding fonts to Font Reserve:

1 At the Finder, select the folder or volume containing the fonts you want to add as a
set.

2 Drag and drop the fonts into the Sets area or onto the DropSet applet.

3 If the Adding Fonts panel displays, specify how to add the font files. See “Adding
Fonts to Font Reserve” on page 44 for more information.

4 Change the name of the set if you wish. By default, the sets are named according to
the volume or folder name.

Note: If you add fonts via the vault method, and some of the fonts are duplicates of
fonts in your database, Font Reserve will not add the fonts. However, Font Reserve will
create font references in the set that point to the existing fonts in your database.

Adding Fonts to an Existing Set and to Font Reserve
If you want to add a font to a set — but the font isn’t in Font Reserve — you can add
it to the set and to Font Reserve simultaneously. For example, if you received a set
from a client but they forgot to give you one font, you can add that font to the set
later. To add a font to a set while adding it to Font Reserve:

1 At the Finder, select the fonts you want to add to the set.

2 Drag and drop the fonts on the set.

3 If the Adding Fonts panel displays, specify how to add the font files.

Note: Font Reserve adds the fonts to Font Reserve and places font references in the set.

Preventing “Duplicate” Fonts and Sets
Although Font Reserve allows you to give sets the same name and it allows you to
place fonts with the same name in a single set, doing so can cause confusion. We rec-
ommend that you give sets unique names and avoid placing font references with the
same name in the same set (for example, two Helveticas from different foundries).
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Working with Sets

Since sets contain font references rather than fonts, you can modify the contents of
sets easily. You can move font references to other sets, delete font references from
sets, delete entire sets of fonts from Font Reserve, and share sets with other users.
To provide a service bureau with a job’s fonts, you can quickly create a folder of
fonts from a set.

Moving Font References to Other Sets
You can move or copy font references from one set to another. For example, if you
accidentally place a font reference in the wrong set, you can move it to the correct set.
To move or copy font references from one set to another:

1 Open the set containing the font references you want to move.

2 Select the font references to move. Click to select a font reference, Shift+click to
select multiple font references, and marquee to select a range of continuous font ref-
erences.

3 To move the font references, drag and drop them on another set. To copy the font
references into another set, press the Option key while you drag and drop them on
another set.

Moving the GillSans font reference from the Letterhead set to the Features set.

Tip: To scroll the Sets area, drag fonts to the title bar (to scroll up) or to the horizontal
scroll bar (to scroll down).
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Deleting Font References from Sets
You can modify the contents of a set by deleting font references. For example, you may
change the fonts required for a job and wish to update the set. Deleting font references
does not delete the fonts from Font Reserve or delete original font files. To delete font
references from sets:

1 Open the set containing the font references you want to delete.

2 Select the font references to delete. Click to select a font reference, Shift+click to
select multiple font references, and marquee to select a range of continuous font ref-
erences.

3 Click the Delete button on the Browser.

4 An alert displays asking you to confirm the deletion. Click Delete.

Tip: To bypass the delete alert, press the Option key while you click the Delete button.

Deleting Sets of Font References
You can delete entire sets, which will delete the nested sets and font references. You
may wish to delete sets when you’ve finished working on a client’s job, but need to
maintain the fonts in Font Reserve. To delete sets of font references:

1 Select the sets to delete. Click to select a set, Shift+click to select multiple sets, and
marquee to select a range of continuous sets.

2 Click the Delete button on the Browser.

3 An alert displays asking you to confirm the deletion. Click Delete.

Tip: To bypass the delete alert, press the Option key while you click the Delete button.

Deleting Sets and Removing Fonts from Font Reserve
You can delete a set and simultaneously remove the fonts from Font Reserve. For
example, if you add fonts for a job as a set, then finish the job, you may wish to delete
the set and remove the fonts from your computer. To delete a set and remove the fonts
from Font Reserve:

1 Select the sets containing the fonts you want to remove. Click to select a set,
Shift+click to select multiple sets, and marquee to select a range of continuous sets.

2 Press Command+Shift and click the Delete button on the Browser.
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3 An alert displays asking you to confirm the deletion. Click Delete.

4 The fonts are deleted from Font Reserve, but the empty set remains. To delete the
set, select it and click the Delete button on the Browser.

Exporting Sets of Font References
You can share your sets with other users by exporting sets. Exported sets contain infor-
mation about the fonts — not font files — so the users you share the sets with must
have the exact same fonts in their database to use the sets. To export sets:

1 Select the sets you want to export. Click to select a set, Shift+click to select multiple
sets, and marquee to select a range of continuous sets.

2 Click the Export button.

3 Use the standard directory dialog box to create a new folder or navigate to a location
for the exported sets.

The Export selected sets dialog box.

4 Click Select to create a file of exported sets.

A file for each set you export is placed in the location you specify. The exported set
files are named according to the set names and look like this . You can email the set
files to other users or make them available on a network.

Importing Sets of Font References
To use sets from another Font Reserve user, you can import their set files. When you
import a set, Font Reserve creates a new set with the same name and attempts to create
the same font references. If the exact same fonts do not exist in your database, Font 
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Reserve displays an alert showing you which fonts will not be included in the set.
Therefore, to import sets reliably, you should import sets that reference fonts that are
in your database. To import a set:

1 Copy the set file to your hard drive or make sure you can access it over a network.

2 Click the Import button.

3 Use the standard directory dialog box to navigate to the set files, which will look like
this .

4 Select a set file and click Open. (You can import only one set at a time.)

Note: If the imported set has the same name as one of your existing sets, you will end
up with two sets that have the same name. You may wish to change the name of the
imported set or delete one of the sets.

Backing Up Sets and Using Sets with a New Database
The sets you create are saved in the Catalog folder inside the Font Reserve Database
folder. Therefore, if you create a new database, it will not include any sets. To back up
sets, export them and save them on another volume. To use sets with a new database,
export them and import them when another database is active.

Delivering a Set to a Service Bureau
When you’re working with sets, you’re working with font references. However, when
it’s time to deliver fonts to a service bureau, you need the original font files.

To create a folder of fonts for delivery to a service bureau, drag the set icon from the
Sets area to the Finder. This will create a folder on the desktop, with the same name as
the set, that contains a copy of each font in the set. (If fonts in the set were added via
the alias method, Font Reserve must be able to access the original font files to create
copies of them.)

Activating and Deactivating Sets
To activate or deactivate font sets, select the sets and use the Perm, Temp, and Deact
buttons on the Browser. See “Activating/Deactivating Fonts” on page 70 for more
information.
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Creating Nested Sets

You can place sets within other sets, then manipulate the sets individually or all at
once. For example, if you’re working on a magazine, you may have a set for the entire
magazine that contains an individual set for each section. When you’re printing a
proof of the magazine, you can activate the entire set. However, if you’re simply edit-
ing one section, you can activate its individual set. In this section, the entire set is
referred to as the “parent” set; sets within it are referred to as “child” sets.

Placing a Set in Another Set
You can place a set inside another set, or you can copy a set into another set. To place
or copy a set into another set:

1 Select the child sets. Click to select a set, Shift+click to select multiple sets, and mar-
quee to select a range of continuous sets.

2 To move the child sets into the parent set, drag and drop them on the parent set. To
copy the child sets into the parent set, press the Option key while you drag and drop
them on the parent set.

Placing sets inside other sets. In this example, the Features set is inside the 5280 Magazine set,
and remains as an individual set as well.

Note: If you place a copy of a set in another set, the two copies of the set are not linked
to each other. Therefore, if you add fonts to an individual set, the fonts will not be
added to a nested set of the same name.

Removing Sets from Other Sets
To move a child set outside its parent set, select it and drag it to the title bar of the Sets
area (for example, drag it on top of the Name column). To copy a child outside its par-
ent so it’s listed individually and within the set, press the Option key while you drag
the set to the title bar.
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Viewing and Sorting Sets

The Sets area in the Browser lists all your sets, regardless of the filter in effect. The
area is scrollable and resizable so you can quickly find the set you need. Sets are
always sorted alphabetically by name, but you can change the sorting order of font
references within the sets.

The Sets area lists sets alphabetically by name.

The Sets area works as follows:

• Font references within sets are sorted according to the underlined column. To
change the sorting order, simply click a column heading or choose an option from
the Sort List submenu of the View menu.

• All font references are always listed in the Sets area. Commands in the Filter menu
have no effect on the Sets area.

• The Group by Family or Group by Suitcase commands in the View menu have no
effect on the Sets area.

• To view the contents of a set, click the triangle next to the set name. Nested sets will
be listed first alphabetically, followed by font references.

• The columns displayed in the Sets area are controlled by the Columns panel in the
Preferences dialog box (Edit menu). The Fonts area and the Sets area always display
the same columns.

Note: Do not double-click a set to open it. This will open a Preview for each font in
the set — which can be time consuming. If you accidentally double-click a set, press
Command+Period to prevent the Previews from opening.
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Chapter 10: Typical Configurations

Font Reserve is designed for publishers — freelance graphic designers; advertis-

ing agencies; workgroup publishers producing magazines, newspapers, and

books; and service bureaus and printers. Each type of typical user handles fonts

differently, with freelance graphic designers typically maintaining their own

fonts, workgroups preferring to share the same fonts, and service bureaus man-

aging client’s fonts. Font Reserve provides different methods for adding, activat-

ing, and managing fonts to suit these different methods of working with fonts.

As you continue to work with Font Reserve, you’ll discover the methods that

work best for your work environment. However, until you’re comfortable with

the software, you may wish to use one of the typical configurations provided

here. Keep in mind that these configurations are simply suggestions and may

need to be modified to suit your needs.
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Freelance Graphic Designer

Freelance graphic designers usually own a great deal of fonts while occasionally down-
loading new fonts from the web or receiving fonts from clients. Taking advantage of sev-
eral key features in Font Reserve will help freelancers work with their fonts more effi-
ciently. Freelancers that are accustomed to using Suitcase can set up Font Reserve to
mimic Suitcase if they wish.

Option 1: Using Font Reserve Efficiently
Consolidate all the fonts stored on your hard drive into the vault. This ensures that all
your fonts are in one place and always available. To do this, use either the Move into
Vault or Copy into Vault setting in the Adding Fonts panel when you add fonts. (If
you have backup copies of your fonts on another volume, use the Move into Vault
option so you don’t have two copies of each font on your computer.)

If you add fonts from removable media, for example ZIP cartridges or CD-ROM, and
you don’t have enough space on your hard drive to store all these fonts, add these fonts
to Font Reserve using the alias method. Use the Leave in Place setting in the Adding
Fonts panel when you add the fonts. This allows you to catalog all your fonts without
storing them all on your hard drive. When you want to use these fonts, you will have
to mount the appropriate volume; Font Reserve will notify you when the need arises.

Once your fonts are in the database, you can use Font Reserve to help you clean up
your font library by removing unnecessary fonts. For example, you can use the Show
Duplicate PS Names filter to display all your fonts with the same PostScript name,
then review the fonts to determine if you can delete any of them. You may have two
versions of the same font, and decide that you only need to keep one. You will
undoubtedly find fonts that you don’t need. Before you delete any fonts, be sure that
these particular fonts are not required for a job or project that you may need to work
on at some point.
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Once your font library is cleaned up, create sets for your current clients and projects.
You can then activate sets permanently for ongoing jobs and activate sets temporarily
for quick jobs. When you finish a job, you can simply drag the project’s set out of the
Browser to create a copy of the fonts for your service bureau. If you’re editing quick
jobs here and there, you can allow Font Reserve to activate fonts used in documents
automatically (provided that you’re not using PageMaker or Illustrator). If you’re using
QuarkXPress, take advantage of the Quark XTension provided with Font Reserve to
ensure that you’re activating the appropriate fonts.

In addition to creating sets, scan through your fonts and activate permanently any
fonts that you use often. For example, activate the fonts used in your own letterhead
and logo, and activate Zapf Dingbats, Symbol, Times, and Helvetica.

When you acquire new fonts, add them to the vault as well. Depending on how soon
you’ll be using the fonts, you can activate the fonts as you add them by clicking
Activate added fonts automatically in the Adding Fonts panel.

Option 2: Setting Up Font Reserve to Mimic Suitcase
If you’re accustomed to using Suitcase, or if you prefer to store fonts with specific jobs,
you can set up Font Reserve to mimic suitcase. When you add fonts, use the alias
method by clicking Leave in Place in the Adding Fonts panel. Your font files will
remain scattered throughout your hard drive and they will not be added to the vault.
To further mimic Suitcase, choose View ➛ Group by Suitcase when viewing fonts in
the Browser.

Even if you use the alias method to add fonts and view fonts according to suitcases,
you can still take advantage of Font Reserve’s unique features such as sets, owners,
classes, and filters.
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Advertising Agency or Workgroup Publisher

If more than one computer is involved in your publishing process, font management
becomes extremely important. Any variation in fonts can cause missing fonts prob-
lems, inaccurate substitutions, and text reflow. In addition, administrators must ensure
that the company owns licenses for the fonts used in all projects. You can use Font
Reserve features to control these issues in a variety of ways.

Option 1: Each User Manages Their Own Fonts
If the Font Reserve users are not on a network, if they don’t work on similar docu-
ments, or if they don’t want to keep fonts on a centralized font server, each user can
manage their own fonts as a freelance graphic designer would. Each user maintains his
or her own font library stored in his or her own vault.

If the Font Reserve users are working over a network on the same documents — for
example, at a site using the Quark Publishing System — users can still manage their
own fonts. To prevent problems, the users must obtain their fonts for common jobs
from the exact same source. For example, if a user receives a CD-ROM of fonts with
Adobe PageMaker, they cannot be sure that the font versions are the same as fonts
received on a CD-ROM with Adobe Photoshop.

The administrator should create the master font library, ensuring that all the fonts in
the library have been properly licensed by the company, and that the company owns
sufficient licenses for each of the fonts in their library. The administrator can distrib-
ute this library to each of the users in the workgroup by copying the font library to
each user’s machine, or placing the font library on an accessible server so each user can
download and add these fonts to Font Reserve themselves. For special projects, the
administrator can place the required or approved fonts for the project on a common
server for users to copy to their machines. Once the users have copied the fonts to
their machines, they can decide whether to add fonts via the alias or vault method, and
manage their fonts as they wish.

Option 2: Using Copies of the Same Database
To ensure that users have the same fonts, the administrator can create a master Font
Reserve database. The master database — which includes copies of all the fonts in its
vault — is then distributed to all the users in the workgroup. The administrator can
maintain the master database and determine how often to redistribute the master
database to all the users in the workgroup.
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To create the master database, the administrator adds all the fonts to Font Reserve using
the vault method. The master database can also include all the custom sets, filters, classes,
owners, and foundries appropriate to the workgroup. The administrator then distributes
the master database to all the users by copying the database folder to each of the client
machines. The users on the client machines select the master database folder that was
copied to their hard drive through the Font Reserve Settings control panel.

Users can customize their copy of the master database by adding their own fonts
(either via the vault or alias methods), or by creating their own sets, filters, classes,
owners, and foundries. However, if the master database is updated and redistributed,
the users will lose their customizations. To maintain their customization, users can
export their sets, filters, classes, owners, and foundries before the database is updated,
then import them into the new database. See “Saving Classes, Owners, and Foundries”
on page 141 and “Exporting Sets of Font References” on page 149.

Sharing Fonts on a Server
Many large workgroup environments prefer to store their font library on a centralized
“font server,” and have all the users access the fonts over the network. This provides the
administrator with tight control over the company’s font library. Font Reserve allows
you to create this type of a setup.

To do this, the administrator creates one master database that accesses the fonts over
the network, and then distribute copies of this database to all the user within the
workgroup. To create this database, ensure that all the fonts you want to add to the
master database reside somewhere on the server volume. Mount the server volume on
the client machines. On the client machine, turn on Font Reserve and drag the server
volume icon into the Browser. Click Leave in Place in the Adding Fonts panel. Font
Reserve creates an alias to each font, which remains on the server. Since no fonts are
added via the vault method, the vault remains empty.

Once the database is created, the administrator distributes it to all the users in the
workgroup by copying the database folder to each of the client machines. The users on
the client machines select the master database folder that was copied to their hard drive
through the Font Reserve Settings control panel.

To use this method, the font server volume must be mounted on each of the client
machines whenever the users need to access the fonts. If the server volume is not
mounted when the user attempts to access a font, Font Reserve will prompt you to
mount the server.
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When a user activates a font through their local Font Reserve database, the font is acti-
vated on the server. Font Reserve activates fonts in such a way that multiple users can
access and activate the same fonts at the same time. If users find this approach too
slow due to network traffic or other issues, they can choose to activate fonts using the
Activate Copies setting in the Activation panel. When a user activates a font with this
option in effect, Font Reserve makes a local copy of the font, and the font is activated
on the user’s machine rather than over the network. When the user deactivates the
font, the copy is removed from the local machine.

If new fonts are added to the font server, they must be added (again, using the alias
method) to the Font Reserve databases on each of the client machines. This can be
done by adding the fonts to the master database and redistributing the database to all
client machines, or by manually adding the new fonts to each of the client machines.
You can also use the powerful AppleScript support within Font Reserve to automate
the updating of the client databases.

Sharing Sets, Classes, Filters, Owners, and Foundries
If Font Reserve users are working with copies of the same Font Reserve database, they
will have the same initial sets, filters, classes, owners, and foundries. If the system
administrator or any other user creates a helpful item — such as a list of owners —
they can export that item and distribute to other users.

The ability to import and export custom items is especially useful when working with
sets. Once a user creates a set for a specific job or project, the set can be exported and
copied to all the other users working on the same job or project. Each user can import
the set into their Font Reserve database, and the set will be automatically created. This
helps ensure consistency with the fonts used on a particular job or project. See
“Exporting Sets of Font References” on page 149 for more information.
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Service Bureau or Printer

Service bureaus and printers have font-management issues unlike most other users:
handling the scores of fonts delivered by clients each day, ensuring that the appropriate
fonts are used to output each job, controlling the number of active fonts, and deleting
fonts that are no longer necessary. Fortunately, many features in Font Reserve are
designed to address service bureau-specific issues.

Managing House Fonts
Service bureaus generally own an extensive library of fonts that may be used to print
their materials or to print documents for clients that do not provide fonts. To keep
these fonts separate from clients’ fonts, the service bureau’s fonts can be stored in the
vault. There will never be a question about where the font files are or who they
belong to.

Adding Clients’ Fonts
Whether you require clients to deliver fonts with jobs or they’re educated enough to
do it on their own, you’re likely to receive anywhere from a few individual font files to
a hundred or more fonts with each job. The way you add those fonts to the database
will depend somewhat on the nature of the client or the nature of the job.

Generally, it makes sense to keep the client fonts together with the rest of the client
job files. You could set up a folder hierarchy in which you maintain all customer jobs
along with their fonts. When a customer brings their job in, it is added to this hier-
archy, either on a server, or on one of the operators machines. When you are ready
to run the job, the fonts need to be added to Font Reserve. The way you add those
fonts to the database will depend somewhat on the nature of the client or the nature
of the job.

• For a repeat client that prints the same job on a regular schedule, you might add the
fonts as a set via the alias method, and tag these fonts with the name of that owner
or that particular job. Then any time the client shows up, you activate the set, mak-
ing sure the font files are available, and print their job. Since you’re keeping the fonts
on the machine, and the client has a set for the job, you don’t need to worry about
deleting the fonts later.
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• For a new client with a one- or two-page job, you might use the Add temporarily
Expert Option. The fonts are added to the database and immediately activated;
when you shut down the computer, the fonts are removed from the database. For a
quick job, especially one with only a few fonts, you may not want to bother creating
a new owner or set that you would need to delete later. So add the fonts temporarily
to the Fonts area. If you receive this type of job often, you might set up the
DropFont applet specifically to handle these fonts.

• For a client with a large job, especially one with many fonts, add their fonts as a set
via the alias method. (Do not add the fonts temporarily as the output may take sev-
eral days and the computer is likely to be shut down.) It’s particularly important
that you add these fonts as a set, and that you tag them with the owners name. If the
publication includes many advertisements, the document may require one or two
fonts from 30 or 40 families, all coming from a variety of sources. In this type of
publication, it wouldn’t be uncommon to have two versions of the same font used:
for example, two versions of Garamond Book used by different designers in different
ads. Yet each ad requires their specific version of the font. In this situation, it’s
important that you know precisely which fonts were received with the publication
and that those fonts are activated.
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Chapter 11: Troubleshooting

You may encounter three types of issues while working with Font Reserve: general

program errors, memory-related issues, and performance-related issues. This sec-

tion describes typical issues you may have with the software and offers solutions.

You may wish to skim through this section so you’ll easily recognize these issues

and know that you can attempt to resolve them.

If the solutions offered here do not solve any problems you’re experiencing — if

you experience other types of problems — please contact DiamondSoft technical

support at techsupport@diamondsoft.com or (415) 381-3303.



Solving Program Errors

You may occasionally encounter an application error while working with Font Reserve.
The error will be indicated by an alert that says “A program error occurred,” which
may be followed by additional information. Most often, these errors are transient,
meaning that they are not likely to reoccur after you restart your system. These errors
are generally not major problems, and once resolved, should not affect the operation
of Font Reserve.

If you encounter one of these errors, try the following procedures, in order, until one
fixes the problem:

• Quit and relaunch the Browser.

• Quit the Browser and open the Font Reserve Settings control panel. Turn Font
Reserve off and back on again using the On and Off buttons at the top of the dialog
box. Relaunch the Font Reserve Browser.

The On and Off buttons in the Font Reserve Settings control panel.

• Restart your computer.

• Increase the amount of RAM allocated to Font Reserve (see “Changing the Memory
Partition” on page 22), then restart your computer.

If the problem still persists, report the problem to DiamondSoft technical support at
techsupport@diamondsoft.com or (415) 381-3303.

The worst case scenario is that your database has become corrupt and will need to be
rebuilt or replaced with a backup.
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Handling Memory Issues

The default memory settings for Font Reserve and the Browser should be sufficient for
most typical operating conditions. However, in certain situations, you may need to
increase the memory partition either temporarily or permanently.

Increasing Memory Temporarily or Permanently
If you’re planning to add a large number of fonts all at once, or if you’re planning to
print a specimen book containing a large number of fonts, you should probably
increase the amount of RAM allocated to Font Reserve and the Browser for the dura-
tion of the task.

If you have a large number of fonts in Font Reserve (3,000 or more), or if you habitu-
ally group fonts by family or suitcase, we recommend that you increase permanently
the amount of RAM allocated to Font Reserve and the Browser.

Responding to Memory-Related Errors
Increase the memory if it seems that Font Reserve is performing tasks slowly, or if you
receive a low-memory error message such as: “Font Reserve is getting low on memory.
You may want to adjust its memory setting,” or “Font Reserve Browser is getting low
on memory. You may want to adjust its memory setting.”

If the warning refers to the Browser, quit the Browser. At the Finder, locate and select
the Font Reserve Browser application in the Font Reserve 2.0 Folder. Press
Command+i to display the Info dialog box, then increase the value in the Preferred
Size field.
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The Finder’s Info dialog box for the Font Reserve Browser application.

If the warning refers to Font Reserve, quit the Browser and open the Font Reserve
Settings control panel. Turn Font Reserve off using the Off button at the top of the
dialog box. In the Settings area, click the Memory button. Increase the value in the
Preferred Size field, then click OK. Click the On button to start Font Reserve with the
new memory allocation.

The Memory Requirements dialog box lets you change the memory allocated to Font Reserve.
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Resolving Performance Issues

In general, the performance of Font Reserve is based on a number of factors, including:
the size of your database, the amount of RAM allocated to Font Reserve, the speed of
your machine, and the location of your physical font files. To maximize the perform-
ance of Font Reserve on your machine, you can use the alphabet strip to limit the num-
ber of fonts displayed, increase the memory allocated to Font Reserve, and defragment
the drive that contains your database.

Using the Alphabet Strip
If you have a large number of fonts in your database, you will notice a great improve-
ment in general performance if you consistently use the alphabetic strip above the
Fonts area in the Browser. Rather than displaying all your fonts at once, use the alpha-
betical indices to display only fonts that begin with specific letters. See “Displaying
Fonts According to the First Letter” on page 83 for more information.

Increasing RAM Allocated to Font Reserve
You can improve overall performance, up to a point, by increasing the amount of
RAM allocated to Font Reserve (not the Browser). Use the following table as a rule of
thumb:

Number of Fonts RAM Allocated to Font Reserve

<3000 Default RAM up to 5MB

3000–5000 6MB

5000–7000 7MB

7000–10000 8MB

>10000 10MB*

*Increasing RAM above 10MB probably will not yield a huge performance increase.

Defragmenting the Database’s Hard Drive
Font Reserve’s performance will increase if you defragment the drive containing your
Font Reserve database. Defragmenting your drive will defragment the Font Reserve
database files, which will result in improved database performance.
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A
Acrobat Reader Installer, using to install

ATM, 9

Acrobat Reader, required fonts for, 10

Activate Permanently command (Edit
menu), 71

Activate Temporarily command (Edit
menu), 71

Activating fonts

Automatically, 73

Disabling auto-activate feature, 73

With QuarkXPress, 73

Handling conflicts, 75–76

Font ID conflicts, 75

Menu name conflicts, 75–76

Keeping all your fonts active, 66

Methods for, 66–69

Activating copies of fonts, 68–69

Activating fonts “in place,” 67

Permanently, 70

Reaching the Mac OS limit, 69

Selecting fonts to activate/deactivate,
70–71

Setting toggle preferences to
activate/deactivate fonts, 72

Temporarily, 70

Activating fonts in suitcases, 87

Activation panel (Preferences dialog
box), 40

Active attribute (Filter criteria), 92

Active font status, 74

Active Fonts command (Filter menu), 90

Activity log, 54–55

Add Ownership command (Owners
menu), 82, 130

Add time is last scan (Filter criteria), 94

Adding fonts

Activating simultaneously, 51–52

Drag-and-drop, 46

Methods for, 42–43

Alias method, 43, 45, 47

Vault method, 42–43, 45, 47

Scan Folder command (File menu), 46

Scanning fonts to add, 47–48

Add phase, 48

Check phase, 48

Match phase, 48

Pausing or stopping, 48

Scan phase, 48

Setting preferences for adding fonts,
44–45

Temporarily, 49–50

Specifying, 49–50

Using DropSet for, 50

Adding Fonts panel (Preferences dialog
box), 40, 44

Advertising agency, typical configuration,
156–157

Alphabet strip, using, 83
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ATM Deluxe, 43

ATM, using with Font Reserve, 9–10

ATM Deluxe, 9–10, 43

Installing standard ATM, 9

“Auto-Activated Fonts” set, 73

Automatically activating fonts, 7, 73

B
Backing up the database, 26

Backing up the catalog, 26

Using a backup to recover files, 26

Benefits of adding fonts to Font Reserve, 2

Bitmap font icon, 34

Blackletter command (Class menu),
121–122

Browser, 28–40

Bitmap icon, 34

Columns of information, 31

Deact button, 29, 30

Delete button, 30, 32

Drag-and-drop support, 29

Dragging files out to copy fonts, 29

Export button, 30

Family icon, 34

Filter button, 29

Folder icon, 34

Fonts area, 33–34

Icons in the Browser, 34–35

Browser (continued)

Import button, 30

Italic type, indicating font aliases, 28

Menus, 36–38

New button, 29, 32

Opening the Browser, 28

Opening a set, family, or suitcase, 31

Padlock icon, 34

Perm button, 29, 30, 71, 150

Preferences, 39–40

Preview button, 29

PS Outline (MM) icon, 35

PS Outline icon, 35

PS Pair (3) icon, 35

PS Pair icon, 34

PSMM icon, 35

PSOutline (3) icon, 35

Roman type, indicating fonts in vault,
28

Selecting items in Browser, 28

Sets area, 31–32

Sorting order of fonts, 31

Suitcase icon, 34

Temp button, 29, 30

Toggle activation button, 30

TrueType GX icon, 35

TrueType icon, 35

TypeOne GX icon, 35
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Browser menus, 36–38

Class menu, 37

Edit menu, 36

File menu, 36

Filter menu, 37

Font menu, 38–40

Foundry menu, 38

Owner menu, 38

Specimen menu, 38

View menu, 37

Window menu, 38

Browser Preferences dialog box, 39–40

Activation panel, 40

Adding Fonts panel, 40

Cancel button, 39

Character Map panel, 40

Columns panel, 40

Displaying a panel, 39

Getting help, 39

OK button, 39

Opening preferences, 39

Paragraph panel, 40

Previews panel, 40

Sample panel, 40

Use Defaults button, 39

Waterfall panel, 40

C
Catalog, 2

Character Map, 107

Customizing, 108

Displaying, 107

Pasting characters into documents, 108

Character Map panel (Preferences dialog
box), 40, 108

Clarendon command (Class menu),
121–122

Class column, 123

Class (Filter criteria), 92

Class menu, 37, 120

Classes, working with, 120–126

Blackletter, 121

Changing a font’s class, 123

Clarendon, 121

Creating backups of, 141

Creating classes, 124

Default font classification, 120–122

Deleting classes, 125

Editing classes, 125

Exporting classes, 125–126

Grotesque sans, 122

Humanist sans, 122

Importing classes, 126–127

Incorrect class, 120

Modern, 121
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Classes, working with (continued)

Oldstyle, 121

Ornamental, 122

Sans, 122

Script, 122

Serif, 121

Sharing with other databases, 141

Slab serif, 122

Symbol/Pi, 122

Transitional, 121

Uncial, 121

Viewing a font’s class, 123

Clients’ fonts, handling, 158–159

Clipping system extension (Mac OS), 8

Close Window command (File menu),
103

Collect for output features, 7

Columns panel (Preferences dialog box),
40, 78

Components of Font Reserve, 5–7

Aliases to applications, 7

DropFont applet, 6

DropSet applet, 7

Font Reserve application, 5

Font Reserve Browser, 6

Font Reserve Data folder, 5

Font Reserve Settings control panel, 6

Font Reserve system extension, 7

FR Relauncher, 7

Copy into Vault button (Adding Fonts
panel), 45

Copying fonts for a service bureau, 62–63

Corrupt fonts, 55–56

D
Database, 5

Backing up, 26

Creating multiple, 24

Moving, 23

Sharing copies of, 25

Fonts in the vault, 25

Fonts on a server, 25

Database, sharing, 156–157

Deact button (Browser), 29, 30, 72, 150

Deactivate command (Edit menu), 72

Deactivating fonts, 72

Default command (Class menu), 118,
123

Default command (Foundry menu), 136,
137

Delete button (Browser), 30, 60, 148, 149

Deleting fonts, 60–62

Disabling Font Reserve, 21

Displaying fonts by first letter, 83

DropFont applet, 46

DropSet applet, 46, 146

Duplicate FOND IDs command (Filter
menu), 90
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Duplicate fonts, 42, 56, 58–59

Location criteria’s effect, 58–59

Duplicate PS Font Names command
(Filter menu), 90

Duplicate sets, 146

E
Edit menu, 36

Edit Classes command (Class menu),
124, 125, 126

Edit Filters command (Filter menu), 95,
96, 97

Edit Foundries command (Foundry
menu), 138, 139, 140

Edit Owners command (Owner menu),
128, 129, 133

Edit Quick Filter command (Filter
menu), 94

Edit Specimen Templates command
(Specimen menu), 114

Enabling Font Reserve, 21

Export button (Browser), 30, 149

F
Families, grouping fonts by, 84–85

Family folder in vault, 42

Family icon, 34

Family name (Filter criteria), 93

File menu, 36

Filter menu, 89

Filter button (Browser), 29, 94

Filters dialog box, 95

Filters, using, 89–97

Checking filters, 96

Custom filters, creating, 95

Custom filters, editing, 95

Custom filters, exporting, 96–97

Custom filters, importing, 97–98

Default filters, 89–90

Active Fonts, 90

Duplicate FOND IDs, 90

Duplicate PS Font Names, 90

In Vault, 90

Last Added Fonts, 90

Orphan Bitmaps, 90

Orphan Outlines, 90

Owned by Default, 90

PostScript Only, 90

TrueType Only, 90

Deleting filters, 96

Filter criteria, defined, 91–94

Active attribute, 92

Add time is last scan, 94

Class, 92

Family name, 93

FOND ID, 93

Foundry, 92

Kind, 92

Location, 93

Menu name, 92
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Filter criteria (continued)

Owners include, 93

PostScript name, 92

Primary owner, 93

Script, 94

Version, 93

Filter Editor dialog box, 91–94

None command (Filter menu), 89–90

Quick Filter Editor dialog box, 91–94

Quick Filter, creating, 94

Finding a font, 88

Folder icon, 34

FOND ID (Filter criteria), 93

Font ID conflicts, handling, 75

Font menu, displaying in Browser, 79

Font references, status, 74

Font Reserve Settings control panel,
16–20

Activate fonts automatically check
box, 17

Database controls, 18–19

Diagnostics area, 20–21

Opening the control panel, 16

Settings area, 19–20

Startup controls, 16–17

Font Reserve XTension, 73

Fonts area (Browser), 33–34

Alphabet strip, 33

Filtering fonts, 33

Fonts area (continued)

Grouped by family, 33

Grouped by suitcase, 34

Jumping to a font, 33

Number of fonts displayed, 34

Quick Preview, 34

System Fonts displayed, 33

Foundries, working with, 136–140

Changing a font’s foundry, 137

Creating backups of, 141

Creating foundries, 138

Default foundry, 136–137

Deleting foundries, 139

Editing foundries, 139

Exporting foundries, 139–140

Importing foundries, 140–141

Sharing with other databases, 141

Unknown foundry, 136

Viewing a font’s foundry, 137

Foundry column, 137

Foundry (Filter criteria), 92

Foundry folder in vault, 42

Foundry menu, 38, 81, 136

Freelance graphic designer, typical config-
urations, 154–155

Storing fonts in the vault, 154

Using Font Reserve similar to Suitcase,
155

Full preview, 102-103
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G
Grotesque sans command (Class menu),

122

Grouped by Family command (View
menu), 57, 71, 84–85

Grouped by Suitcase command (View
menu), 67, 71, 86

Grouping fonts by family, 84–85

Criteria for, 85

Multiple families with the same name,
85

Two versions of one font, 85–86

Grouping fonts by suitcase, 86–87

Viewing active fonts in, 87

H
Humanist sans command (Class menu),

122

I
Import button (Browser), 30, 150

In Vault command (Filter menu), 90

Inactive font status, 74

Installing and uninstalling Font Reserve,
11–14

Entering a serial number, 13

Installing a demonstration version, 13

Installing a licensed copy, 11–12

Uninstalling Font Reserve, 14

J
Jump to dialog box, 88

K
KeyCaps, 107

Kind (Filter criteria), 92

L
Last Added Fonts command (Filter

menu), 90

Leave in place button (Adding Fonts
panel), 45

Location (Filter criteria), 93

Location of aliased font file, 81

Log command (File menu), 54

M
Macros for specimen book headers/foot-

ers, 110–111

Managing fonts, 3, 119–142

Master Juggler, 9, 43

Memory partition, changing, 22

Menu name (Filter criteria), 92

Modern command (Class menu),
121–122

Move into Vault button (Adding Fonts
panel), 45

N
Name conflicts, handling, 75–76

Necessary system fonts, 10
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New button (Browser), 29, 32, 144

New Set command (File menu), 32, 144

None command (Class menu), 123

None command (Filter menu), 33, 88

None command (Foundry menu), 137

O
Object Support Lib system extension, 8

Oldstyle command (Class menu),
121–122

Ornamental command (Class menu),
122

Orphan Bitmaps command (Filter
menu), 56

Orphan fonts, 56–58

Matching, 57–58

Orphan Outline command (Filter
menu), 56

Orphan Outlines command (Filter
menu), 90

Owned by Default command (Filter
menu), 90

Owner column, 131

Owner menu, 38

Owners include (Filter criteria), 93

Owners, working with, 127–135

Add Ownership pop-up menu, 129

Assigning additional owners, 130

Assigning the initial owner, 129–130

Creating backups of, 141

Creating owners, 128–129

Deleting owners, 133–134

Editing the owners list, 133

Exporting the owners list, 134–135

Importing the owners list, 135–136

Managing fonts through owners,
127–128

Primary owner, changing, 130–131

Removing owners, 132

Sharing with other databases, 141

Viewing ownership, 131

P
Padlock icon, 34

Page Grabber Hand tool, 112

PageMaker, 3, 17, 70, 73, 155, 156

Paragraph panel (Preferences dialog
box), 40, 104

Perm button (Browser), 29, 30, 71, 150

Physical font files folder in vault, 42

PopChar, 107

PostScript name (Filter criteria), 92

PostScript Only command (Filter
menu), 90

Preferences command (Edit menu),
39-40

Preview button (Browser), 29, 102

Previewing fonts, 3, 100

Character Map panel (Preview), 103

Closing previews, 103
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Previewing fonts (continued)

Full preview, 102–106

Character Map, 102

Customizing, 104

Displaying, 102–106

Info, 102

Kerning, 102

Paragraph, 102

Sample, 102

Waterfall, 102

Info panel (Preview), 103

Kerning panel (Preview), 103

Paragraph panel (Preview), 103

Previewing a missing font, 100

Quick preview, 100–101

Customizing, 100–101

Displaying, 100–101

Sample panel (Preview), 103

Understanding previews, 103

Waterfall panel (Preview), 103

Previews panel (Preferences dialog box),
40, 101, 104

Primary owner, 130

Primary owner (Filter criteria), 93

Printer, typical configuration, 158–159

Printing, type book. See Specimen
Templates

Problem fonts, handling, 54–57

Activity Log, deciphering, 54–55

Corrupt fonts, 55–56

Fonts not added, 56

Ignore problems, 56

Repairs, 55

Duplicate fonts, 56

Orphan fonts, 56–57

PS MM icon, 35

PS Outline (3) icon, 35

PS Outline (MM) icon, 35

PS Outline icon, 35

PS Pair (3) icon, 35

PS Pair icon, 34

Q
QuarkXPress, 4, 11, 17, 57, 62, 70, 73, 155

Quick Filter Editor dialog box, 94

R
Remove Ownership command (Owner

menu), 132

Removing fonts, 60–61

Copying fonts out, 63

Deleting, consequences, 60

Removing owners, 127, 132

Reports, generating, 115–117

Catalog Summary Reports, 117

Environment Report, 115
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Reports, generating (continued)

Sets Using Fonts Report, 116–117

Tab-Separated Font Report, 116

Rescan System Fonts command (File
menu), 53

S
Sample panel (Preferences dialog box),

40, 105

Sans serif command (Class menu), 122

Scan Folder command (File menu), 46,
49, 51

Scan System Folder command (File
menu), 144

Script command (Class menu), 122

Script (Filter criteria), 94

Serif command (Class menu), 121–122

Service bureau, delivering fonts to, 62–63

Service bureau, typical configuration,
158–159

Sets, 144–146

Activating and deactivating sets,
150–151

Adding font references, 145

Adding fonts to a set, 146

Backing up, 150

Changing a set’s name, 144

Copying font references, 147

Sets (continued)

Creating, 144–146

While adding fonts, 145–146

An empty set, 144–146

Deleting

Font references, 148

Sets, 148

Delivering sets to service bureaus, 150

Exporting sets, 149

Importing sets, 149–150

Moving font references among sets, 147

Nested sets, 151

Placing sets in other sets, 151

Removing sets from other sets,
151–152

Scrolling the sets area, 145

System Fonts set, 144

Sets area (Browser), 31–32

Settings command (Specimen menu),
109

Show Character Map command (View
menu), 102

Show Info command (View menu), 102

Show Kerning command (View menu),
102

Show Paragraph command (View
menu), 102

Show Sample command (View menu),
102
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Show System Fonts command (Filter
menu), 98

Show Waterfall command (View menu),
102

Slab serif command (Class menu), 122

Sort List command (View menu), 31, 37,
152

Sorting fonts in the Browser, 77–98

Basics of, 79–80

Class, sorting by, 80

Created, sorting by, 80

Displaying different Browser columns,
78–79

Family, sorting by, 80

FOND ID, sorting by, 81

Foundry, sorting by, 81

Kern Checksum, sorting by, 81

Kind, sorting by, 81

Location, sorting by, 81

Menu Names, displayed, 79

Outline Filesize, sorting by, 82

Owner, sorting by, 82

PostScript Names, displayed, 79

Sorting fonts by columns, 80

Version, sorting by, 82

Viewing font information, 78–82

Sorting sets, 152

Special characters, previewing, 107–108

Pasting into documents, 108

Specimen menu, 38, 109

Specimen templates, 109–117

Choosing fonts to print, 112

Customizing, 109–110

Entering macros for header and foot-
er text, 110–111

Importing specimen templates,
113–115

Sending selected fonts to print,
112–113

Status of fonts, determining, 74

Suitcase, 9–10, 43, 57, 155

Setting up Font Reserve to mimic, 155

Suitcase icon, 34

Suitcases, affect on activating fonts, 67

Suitcases, grouping fonts by, 86–87

Symbol/Pi command (Class menu), 122

System Fonts folder, emptying, 10

System fonts, displaying, 98

System fonts, handling, 53

System Requirements, 8

T
Temp button (Browser), 29, 30, 71

Temporary fonts, 49–50

Toggling an inactive font activates it, 72

Transitional command (Class menu),
121–122

Using Font Reserve — 177

Index: Show System Fonts–Transitional



Troubleshooting

Memory problems, 163

Performance problems, 165

Program errors, 162

TrueType GX icon, 35

TrueType icon, 35

TrueType Only command (Filter menu),
90

Type book, printing. See Specimen
Templates

Type folder in vault, 42

TypeOne GX icon, 35

U
Ungrouped command (View menu), 71,

84–85, 86

V
Vault, 2

Version (Filter criteria), 93

Version Number folder in vault, 42

Version numbers, defined, 82

View menu, 37

View menu, Preview options, 102

Viewing fonts in the browser, 77–98

Viewing sets, 152

W
Waterfall panel (Preferences dialog box),

40, 106, 115

Window menu, 38

Workflow with Font Reserve, 3–5

Workgroup publisher, typical configura-
tion, 156–157

WorldScript support, 8

Z
Zoom tool, 109, 112

Zoom Window command (Window
menu), 38
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